This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see [http://www.vmware.com/support/pubs](http://www.vmware.com/support/pubs).
You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
Contents

1 Understanding vSphere Auto Deploy  5
   Introduction to Auto Deploy  5
   Rules and Rule Sets  7
   Auto Deploy Boot Process  8

2 Auto Deploy Roadmap and Cmdlet Overview  13
   Auto Deploy Roadmap  13
   Auto Deploy PowerCLI Cmdlet Overview  15

3 Preparing for vSphere Auto Deploy  17
   Prepare Your System and Install the Auto Deploy Server  18
   Install vSphere Auto Deploy  20
   Install PowerCLI and Prerequisite Software  21
   Using Auto Deploy Cmdlets  21
   Set Up Bulk Licensing  22

4 Managing Auto Deploy with PowerCLI Cmdlets  25
   Assign an Image Profile to Hosts  25
   Assign a Host Profile to Hosts  27
   Assign a Host to a Folder or Cluster  28
   Test and Repair Rule Compliance  28

5 Provisioning ESXi Systems with vSphere Auto Deploy  31
   Provision a Host (First Boot)  31
   Reprovisioning Hosts  32
      Reprovision Hosts with Simple Reboot Operations  32
      Reprovision a Host with a New Image Profile  33
      Applying a Host Profile to Prompt for User Input  34

6 Setting Up an Auto Deploy Reference Host  35
   Understanding Reference Host Setup  35
   Configuring an Auto Deploy Reference Host  37
   Configure ESXi Dump Collector with ESXCLI  37
   Configure Host Profiles for an Auto Deploy Reference Host  38
      Set Up ESXi Dump Collector from the Host Profiles Interface  39
      Set Up Syslog from the Host Profiles Interface  39
      Set Up Networking for Your Auto Deploy Host  40

7 Advanced Management Tasks  41
   Reregister Auto Deploy  41
   Use Hosts with Static IP Addresses  42
vSphere Auto Deploy can provision hundreds of physical hosts with ESXi software. You can specify the image to deploy and the hosts to provision with the image. Optionally, you can specify host profiles to apply to the hosts, and a vCenter Server location (folder or cluster) for each host.

This chapter includes the following topics:
- “Introduction to Auto Deploy,” on page 5
- “Rules and Rule Sets,” on page 7
- “Auto Deploy Boot Process,” on page 8

Introduction to Auto Deploy

When you start a physical host set up for Auto Deploy, Auto Deploy uses a PXE boot infrastructure in conjunction with vSphere host profiles to provision and customize that host. No state is stored on the host itself, instead, the Auto Deploy server manages state information for each host.

State Information for ESXi Hosts

Auto Deploy stores the information for the ESXi hosts to be provisioned in different locations. Information about the location of image profiles and host profiles is initially specified in the rules that map machines to image profiles and host profiles. When a host boots for the first time, the vCenter Server system creates a corresponding host object and stores the information in the database.

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
<th>Source of State Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image state</td>
<td>Executable software to run on an ESXi host.</td>
<td>Image profile, created with Image Builder PowerCLI.</td>
</tr>
<tr>
<td>Configuration state</td>
<td>Configurable settings that determine how the host is configured, for example, virtual switches and their settings, driver settings, boot parameters, and so on.</td>
<td>Host profile, created by using the host profile UI. Often comes from a template host.</td>
</tr>
<tr>
<td>Dynamic state</td>
<td>Runtime state that is generated by the running software, for example, generated private keys or runtime databases.</td>
<td>Stored in host memory and lost during reboot.</td>
</tr>
</tbody>
</table>
Table 1-1. Auto Deploy Stores Information for Deployment (Continued)

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
<th>Source of State Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual machine state</td>
<td>Virtual machines stored on a host and virtual machine autostart information (subsequent boots only).</td>
<td>Managed by vCenter Server system by default.</td>
</tr>
<tr>
<td></td>
<td>- If the virtual machine is in a vSphere HA cluster, deployment works even if the vCenter Server is unavailable because Auto Deploy retains the virtual machine information.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- If the virtual machine is not in a vSphere HA cluster, vCenter Server must be available to supply virtual machine information to Auto Deploy.</td>
<td></td>
</tr>
<tr>
<td>User input</td>
<td>State that is based on user input, for example, an IP address that the user provides when the system starts up, cannot automatically be included in the host profile.</td>
<td>Custom information is stored in an answer file. You can create a host profile that requires user input for certain values. When Auto Deploy applies a host profile that requires an answer to a newly-provisioned host, the host comes up in maintenance mode. You can right-click the host and select <strong>Update Answer File</strong> to be prompted for the information. The answer file information is stored with the host. Each host has one answer file that can include multiple user input items.</td>
</tr>
</tbody>
</table>

Auto Deploy Architecture

The Auto Deploy infrastructure consists of several components.

**Figure 1-1. vSphere Auto Deploy Architecture**

**Auto Deploy server**

Serves images and host profiles to ESXi hosts. The Auto Deploy server is at the heart of the Auto Deploy infrastructure.

**Auto Deploy rules engine**

Tells the Auto Deploy server which image and which host profile to serve to which host. Administrators use the Auto Deploy PowerCLI to define the rules that assign image profiles and host profiles to hosts.
Image profiles

- VMware and VMware partners make image profiles and VIBs available in public depots. Use the Image Builder PowerCLI to examine the depot and the Auto Deploy rule engine to specify which image profile to assign to which host.
- VMware customers can create a custom image profile based on the public image profiles and VIBs in the depot and apply that image profile to the host.

Host profiles

- Define machine-specific configuration such as networking or storage setup. Administrators create host profiles by using the host profile UI. You can export an individual host’s host profile and use the host profile to reprovision that host. You can export the host profile of a template host and use the template profile for other hosts.

Answer files

- Store information that the user provides when host profiles are applied to the host. The answer file might contain an IP address or other information that the user supplied for that host. One answer file can exist for each host. See “Customizing Hosts with Answer Files,” on page 44.

Rules and Rule Sets

You specify the behavior of the Auto Deploy server by using a set of rules written in Power CLI. The Auto Deploy rule engine checks the rule set for matching host patterns to decide which items (image profile, host profile, or vCenter Server location) to provision each host with.

The rule engine maps software and configuration settings to hosts based on the attributes of the host. For example, you can deploy image profiles or host profiles to two clusters of hosts by writing two rules, each matching on the network address of one cluster.

For hosts that have not yet been added to a vCenter Server system, the Auto Deploy server checks with the rule engine before serving image profiles, host profiles, and inventory location information to hosts. For hosts that are managed by a vCenter Server system, the image profile, host profile, and inventory location vCenter Server has stored in the host object is used. You can use Auto Deploy PowerCLI cmdlets to test and repair rule compliance. When you repair rule compliance for a host, the host’s image profile and host profile assignments are updated.

**Note**  You must test and repair rule compliance for any host managed by a vCenter Server system even if those hosts were not added to the vCenter Server system by Auto Deploy.

The rule engine includes rules and rule sets.

### Rules

- Rules can assign image profiles and host profiles to a set of hosts, or specify the location (folder or cluster) of a host on the target vCenter Server system. A rule can identify target hosts by boot MAC address, SMBIOS information, BIOS UUID, Vendor, Model, or fixed DHCP IP address. In most cases, rules apply to multiple hosts. You create rules by using Auto Deploy PowerCLI cmdlets. After you create a rule, you must add it to a rule set. Only two rule sets, the active rule set and the working rule set, are supported. A rule can belong to
both sets, the default, or only to the working rule set. After you add a rule to a rule set, you can no longer change the rule. Instead, you copy the rule and replace either items or patterns. By default, Auto Deploy uses the name of the rule for the copy and hides the original rule.

**Active Rule Set**

When a newly started host contacts the Auto Deploy server with a request for an image profile, the Auto Deploy server checks the active rule set for matching rules. The image profile, host profile, and vCenter Server inventory location that are mapped by matching rules are then used to boot the host. If more than one item of the same type is mapped by the rules, the Auto Deploy server uses the item that is first in the rule set.

**Working Rule Set**

The working rule set allows you to test changes to rules before making the changes active. For example, you can use Auto Deploy PowerCLI cmdlets for testing compliance with the working rule set. The test verifies that hosts managed by a vCenter Server system are following the rules in the working rule set. By default, cmdlets add the rule to the working rule set and activate the rules. Use the `NoActivate` parameter to add a rule only to the working rule set.

You use the following workflow with rules and rule sets.

1. Make changes to the working rule set.
2. Use cmdlets that execute the working rule set rules against a host to make sure that everything is working correctly.
3. Refine and retest the rules in the working rule set.
4. Activate the rules in the working rule set.

You can activate the rules explicitly, however, if you add a rule and do not specify the `NoActivate` parameter all rules that are currently in the working rule set are activated. You cannot activate individual rules.

**Auto Deploy Boot Process**

When you turn on a host that you want to provision or reprovision with vSphere Auto Deploy, the Auto Deploy infrastructure supplies the image profile and, optionally, a host profile and a vCenter Server location for that host.

The boot process is different for hosts that have not yet been provisioned with Auto Deploy (first boot) and for hosts that have been provisioned with Auto Deploy and added to a vCenter Server system (subsequent boot).

**First Boot Prerequisites**

Before a first boot process, you must set up your system. Setup includes the following tasks, which are discussed in more detail in Chapter 3, “Preparing for vSphere Auto Deploy,” on page 17.

- Set up a DHCP server that assigns an IP address to each host upon startup and that points the host to the TFTP server to download the gPXE boot loader from.
- Ensure that the Auto Deploy server has an IPv4 address. PXE booting is supported only with IPv4.
- Identify an image profile to be used in one of the following ways.
  - Choose an ESXi image profile in a public depot.
(Optional) Create a custom image profile by using the Image Builder PowerCLI, and place the image profile in a depot that the Auto Deploy server can access. The image profile must include a base ESXi VIB.

(Optional) If you have a reference host in your environment, export the host profile of the reference host and define a rule that applies the host profile to one or more hosts.

Specify rules for the deployment of the host and add the rules to the active rule set.

First Boot Overview

When a host that has not yet been provisioned with vSphere Auto Deploy boots (first boot), the host interacts with several Auto Deploy components.

1. When the administrator turns on a host, the host starts a PXE boot sequence.
   The DHCP Server assigns an IP address to the host and instructs the host to contact the TFTP server.

2. The host contacts the TFTP server and downloads the gPXE file (executable boot loader) and a gPXE configuration file.

3. gPXE starts executing.
   The configuration file instructs the host to make a HTTP boot request to the Auto Deploy server. The HTTP request includes hardware and network information.

4. In response, the Auto Deploy server performs these tasks:
   a. Queries the rule engine for information about the host.
   b. Streams the components specified in the image profile, the optional host profile, and optional vCenter Server location information.

5. The host boots using the image profile.
   If the Auto Deploy server provided a host profile, the host profile is applied to the host.

6. Auto Deploy assigns the host to the vCenter Server system that Auto Deploy is registered with.
   a. If a rule specifies a target folder or cluster on the vCenter Server system, the host is placed in that folder or cluster.
   b. If no rule exists that specifies a vCenter Server inventory location, Auto Deploy adds the host to the first datacenter displayed in the vSphere Client UI.

7. (Optional) If the host profile requires the user to specify certain information, such as a static IP address, the host is placed in maintenance mode when the host is added to the vCenter Server system.
   You must reapply the host profile and answer any questions to have the host exit maintenance mode. See “Applying a Host Profile to Prompt for User Input,” on page 34.

8. If the host is part of a DRS cluster, virtual machines from other hosts might be assigned to the host after the host has successfully been added to the vCenter Server system.

See “Provision a Host (First Boot),” on page 31.
Figure 1-2. Auto Deploy Installation, First Boot

1. The administrator reboots the host.
2. As the host boots up, Auto Deploy provisions the host with its image profile and host profile, which are stored in vCenter Server.
3. Virtual machines are brought up or migrated to the host based on the settings of the host.
   - Standalone host. Virtual machines are powered on according to autostart rules defined on the host.
   - DRS cluster host. Virtual machines that were successfully migrated to other hosts stay there. Virtual machines for which no host had enough resources are registered to the rebooted host.

If the vCenter Server system is unavailable, the host contacts the Auto Deploy server for image profiles and host profiles and the host reboots. However, Auto Deploy cannot set up vSphere distributed switches if vCenter Server is unavailable, and virtual machines are assigned to hosts only if they participate in an HA cluster. Until the host is reconnected to vCenter Server and the host profile is applied, the switch cannot be created. Because the host is in maintenance mode, virtual machines cannot start. See “Reprovision Hosts with Simple Reboot Operations,” on page 32.

Any hosts that are set up to require user input are placed in maintenance mode. See “Applying a Host Profile to Prompt for User Input,” on page 34.

Subsequent Boots Without Updates

For hosts that are provisioned with Auto Deploy and managed by a vCenter Server system, subsequent boots can become completely automatic. The host is provisioned by the vCenter Server system, which stores information about the image profile and host profile for each host in the database.

The boot process proceeds as follows.

1. The administrator reboots the host.
2. As the host boots up, Auto Deploy provisions the host with its image profile and host profile, which are stored in vCenter Server.
3. Virtual machines are brought up or migrated to the host based on the settings of the host.
   - Standalone host. Virtual machines are powered on according to autostart rules defined on the host.
   - DRS cluster host. Virtual machines that were successfully migrated to other hosts stay there. Virtual machines for which no host had enough resources are registered to the rebooted host.

If the vCenter Server system is unavailable, the host contacts the Auto Deploy server for image profiles and host profiles and the host reboots. However, Auto Deploy cannot set up vSphere distributed switches if vCenter Server is unavailable, and virtual machines are assigned to hosts only if they participate in an HA cluster. Until the host is reconnected to vCenter Server and the host profile is applied, the switch cannot be created. Because the host is in maintenance mode, virtual machines cannot start. See “Reprovision Hosts with Simple Reboot Operations,” on page 32.

Any hosts that are set up to require user input are placed in maintenance mode. See “Applying a Host Profile to Prompt for User Input,” on page 34.
Subsequent Boots With Updates

You can change the image profile, host profile, or vCenter Server location for hosts. The process includes changing rules and testing and repairing the host’s rule compliance.

1 The administrator uses the Copy-DeployRule PowerShell cmdlet to copy and edit one or more rules and updates the rule set. See “Auto Deploy Roadmap,” on page 13 for an example.

2 The administrator runs the Test-DeployRulesetCompliance PowerShell cmdlet to check whether each host is using the information the current rule set specifies.

3 The host returns a PowerShell object that encapsulates compliance information.

4 The administrator runs the Repair-DeployRulesetCompliance PowerShell cmdlet to update the image profile, host profile, or vCenter Server location the vCenter Server system stores for each host.

5 When the host reboots, it uses the updated image profile, host profile, or vCenter Server location for the host.

   If the host profile is set up to request user input, the host is placed in maintenance mode. Follow the steps in “Applying a Host Profile to Prompt for User Input,” on page 34.


Figure 1-3. Auto Deploy Installation, Subsequent Boots

Provisioning of Systems that Have Distributed Switches

You can configure the host profile of an Auto Deploy reference host with a distributed switch.

When you configure the distributed switch, the boot configuration parameters policy is automatically set to match the network parameters required for host connectivity after a reboot.

When Auto Deploy provisions the ESXi host with the host profile, the host goes through a two-step process.

1 The host creates a standard virtual switch with the properties specified in the boot configuration parameters field.

2 The host creates the VMkernel NICs. The VMkernel NICs allow the host to connect to Auto Deploy and to the vCenter Server system.
When the host is added to vCenter Server, vCenter Server removes the standard switch and reapply the distributed switch to the host.

**NOTE** Do not change the boot configuration parameters to avoid problems with your distributed switch.
To be successful with Auto Deploy, you have to know the tasks involved in provisioning hosts, understand the Auto Deploy components and their interaction, and know the PowerCLI cmdlets.

This chapter includes the following topics:
- “Auto Deploy Roadmap,” on page 13
- “Auto Deploy PowerCLI Cmdlet Overview,” on page 15

### Auto Deploy Roadmap

Getting started with Auto Deploy requires that you learn how Auto Deploy works, install the Auto Deploy server, install PowerCLI, write PowerCLI rules that provision hosts, and turn on your hosts to be booted with the image profile you specify. Customizations of the image profile, host profile, and vCenter Server location are supported.


To successfully provision the hosts in your environment with Auto Deploy you can follow a few steps discussed in more detail in this document.

1. **Install the Auto Deploy server.**
   - **Windows**
     The Auto Deploy server is included with the vCenter Server installation media. You can install the Auto Deploy server on the same system as vCenter Server or on a different system.
   - **vCenter Server appliance**
     The vCenter Server appliance includes vCenter Server and the Auto Deploy server. You can use both servers on the appliance, use a standalone vCenter Server installation with Auto Deploy on the appliance, or use a standalone Auto Deploy installation with the vCenter Server appliance. The Auto Deploy server on the vCenter Server appliance is disabled by default. See “Using Auto Deploy with the VMware vCenter Server Appliance,” on page 42 for configuration information.

   **NOTE** You cannot use more than one Auto Deploy server with one vCenter Server system.

   See “Prepare Your System and Install the Auto Deploy Server,” on page 18 for information on installing the software, setting up the DHCP server, and downloading the TFTP configuration file.

2. **Install PowerCLI, which includes Auto Deploy and Image Builder cmdlets, and set up remote signing.**
Find the image profile that includes the VIBs that you want to deploy to your hosts.

- In most cases, you add the depots that contain the software that you are interested in to your PowerCLI session, and then select an image profile from one of those depots.
- To create a custom image profile, use Image Builder cmdlets to clone an existing image profile and add the custom VIBs to the clone. Add the custom image profile to the PowerCLI session.

Using Image Builder for customization is required only if you have to add or remove VIBs. In most cases, you can add the depot where VMware hosts the image profiles to your PowerCLI session as a URL.

Use the `New-DeployRule` PowerCLI cmdlet to write a rule that assigns the image profile to one host, to multiple hosts specified by a pattern, or to all hosts.

```
NewDeployRule -Name "testrule" -Item image-profile -AllHosts
```

See “Assign an Image Profile to Hosts,” on page 25.

**NOTE**  Auto Deploy is optimized for provisioning hosts that have a fixed MAC address to IP address mapping in DHCP (sometimes called DHCP reservations). If you want to use static IP addresses, you must create an answer file for each host. See “Use Hosts with Static IP Addresses,” on page 42.

Turn on the host to have Auto Deploy provision the host with the specified image profile.

Set up the host you provisioned as a reference host for your host profile.

You can specify the reference host syslog settings, firewall settings, storage, networking, and so on. See Chapter 6, “Setting Up an Auto Deploy Reference Host,” on page 35.

Create and export a host profile for the reference host.

See the Host Profiles documentation.

To provision multiple hosts, you can use the `Copy-DeployRule` cmdlet.

```
CopyDeployRule -DeployRule "testrule" -ReplaceItem
    my_host_profile_from_reference_host,my_targetcluster
    -ReplacePattern  "ipv4=192.XXX.1.10-192.XXX.1.20"
```

`my_host_profile_from_reference_host` is the name of the reference host profile. `my_targetcluster` is the name of the target cluster.

Turn on the hosts you want to provision.

If the hosts that are specified by the pattern are not currently managed by a vCenter Server system, Auto Deploy provisions them with the already stored image profile and the specified host profile and adds them to the target cluster.

Check that the hosts you provisioned meet the following requirements.

- Each host is connected to the vCenter Server system.
- The hosts are not in maintenance mode.
- The hosts have no compliance failures.
- Each host with an answer file has an up-to-date answer file.

Remedy answer file and compliance problems and reboot hosts until all hosts meet the requirements.

Read Chapter 1, “Understanding vSphere Auto Deploy,” on page 5 for an introduction to the boot process, a discussion of differences between first and subsequent boots, and an overview of using answer files.
Auto Deploy PowerCLI Cmdlet Overview

You specify the rules that assign image profiles and host profiles to hosts using a set of PowerCLI cmdlets that are included in VMware PowerCLI.

If you are new to PowerCLI, read the PowerCLI documentation and review “Using Auto Deploy Cmdlets,” on page 21. You can get help for any command at the PowerShell prompt.

- Basic help: Get-Help cmdlet_name
- Detailed help: Get-Help cmdlet_name -Detailed

**Note**: When you run Auto Deploy cmdlets, provide all parameters on the command line when you invoke the cmdlet. Supplying parameters in interactive mode is not recommended.

**Table 2-1. Rule Engine PowerCLI Cmdlets**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get-DeployCommand</td>
<td>Returns a list of Auto Deploy cmdlets.</td>
</tr>
<tr>
<td>New-DeployRule</td>
<td>Creates a new rule with the specified items and patterns.</td>
</tr>
<tr>
<td>Set-DeployRule</td>
<td>Updates an existing rule with the specified items and patterns. You cannot update a rule that is part of a rule set.</td>
</tr>
<tr>
<td>Get-DeployRule</td>
<td>Retrieves the rules with the specified names.</td>
</tr>
<tr>
<td>Copy-DeployRule</td>
<td>Clones and updates an existing rule.</td>
</tr>
<tr>
<td>Add-DeployRule</td>
<td>Adds one or more rules to the working rule set and, by default, also to the active rule set. Use the NoActivate parameter to add a rule only to the working rule set.</td>
</tr>
<tr>
<td>Remove-DeployRule</td>
<td>Removes one or more rules from the working rule set and from the active rule set. Run this command with the –Delete parameter to completely delete the rule.</td>
</tr>
<tr>
<td>Set-DeployRuleset</td>
<td>Explicitly sets the list of rules in the working rule set.</td>
</tr>
<tr>
<td>Get-DeployRuleset</td>
<td>Retrieves the current working rule set or the current active rule set.</td>
</tr>
<tr>
<td>Switch-ActiveDeployRuleset</td>
<td>Activates a rule set so that any new requests are evaluated through the rule set.</td>
</tr>
<tr>
<td>Get-VMHostMatchingRules</td>
<td>Retrieves rules matching a pattern. For example, you can retrieve all rules that apply to a host or hosts. Use this cmdlet primarily for debugging.</td>
</tr>
<tr>
<td>Test-DeployRulesetCompliance</td>
<td>Checks whether the items associated with a specified host are in compliance with the active rule set.</td>
</tr>
<tr>
<td>Repair-DeployRulesetCompliance</td>
<td>Given the output of Test-DeployRulesetCompliance, this cmdlet updates the image profile, host profile, and location for each host in the vCenter Server inventory. The cmdlet might apply image profiles, apply host profiles, or move hosts to prespecified folders or clusters on the vCenter Server system.</td>
</tr>
<tr>
<td>Apply-EsxImageProfile</td>
<td>Associates the specified image profile with the specified host.</td>
</tr>
<tr>
<td>Get-VMHostImageProfile</td>
<td>Retrieves the image profile in use by a specified host. This cmdlet differs from the Get-EsxImageProfile cmdlet in the Image Builder PowerCLI.</td>
</tr>
</tbody>
</table>
### Table 2-1. Rule Engine PowerCLI Cmdlets (Continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repair-DeployImageCache</td>
<td>Use this cmdlet only if the Auto Deploy image cache is accidentally deleted.</td>
</tr>
<tr>
<td>Get-VMHostAttributes</td>
<td>Retrieves the attributes for a host that are used when the Auto Deploy server evaluates the rules.</td>
</tr>
</tbody>
</table>
Preparing for vSphere Auto Deploy

Before you can start to use vSphere Auto Deploy, you must prepare your environment. You start with server setup and hardware preparation. You must register the Auto Deploy software with the vCenter Server system that you plan to use for managing the hosts you provision, and install the VMware PowerCLI.

- **Prepare Your System and Install the Auto Deploy Server** on page 18
  Before you turn on a host for PXE boot with vSphere Auto Deploy, you must install prerequisite software and set up the DHCP and TFTP servers that Auto Deploy interacts with.

- **Install vSphere Auto Deploy** on page 20
  Install vSphere Auto Deploy to provision and customize physical hosts by loading the ESXi image directly into memory. You can provision and reprovision hundreds of ESXi hosts efficiently with vCenter Server.

- **Install PowerCLI and Prerequisite Software** on page 21
  Before you can run Auto Deploy cmdlets to create and modify the rules and rule sets that govern Auto Deploy behavior, you must install vSphere PowerCLI and all prerequisite software. The Auto Deploy cmdlets are included with the PowerCLI installation.

- **Using Auto Deploy Cmdlets** on page 21
  Auto Deploy cmdlets are implemented as Microsoft PowerShell cmdlets and included in vSphere PowerCLI. Users of Auto Deploy cmdlets can take advantage of all PowerCLI features.

- **Set Up Bulk Licensing** on page 22
  You can use the vSphere Client or ESXi Shell to specify individual license keys, or you can set up bulk licensing by using PowerCLI cmdlets. Bulk licensing works for all ESXi hosts, but is especially useful for hosts provisioned with Auto Deploy.
Prepare Your System and Install the Auto Deploy Server

Before you turn on a host for PXE boot with vSphere Auto Deploy, you must install prerequisite software and set up the DHCP and TFTP servers that Auto Deploy interacts with.

**CAUTION** If you set up Auto Deploy to boot a host, vSphere checks each of the local storage devices on the system for existing partitions. To avoid the possibility of data loss, vSphere does not create partitions under the following conditions:

- A local storage device contains a GPT partition map.
- A local storage device contains an MBR partition table that defines at least one partition.
- Storage is remote.

If hosts have local storage with a partition table that vSphere does not recognize, such as Linux Logical Volume Manager, vSphere overwrites the storage and creates new partitions. To make sure local storage is not considered for partitioning, you can physically disconnect that storage.

**Prerequisites**

- Ensure that the hosts you will provision with Auto Deploy meet the hardware requirements for ESXi 5.0. See ESXi Hardware Requirements in *vSphere Installation and Setup*.

  **NOTE** You cannot provision EFI hosts with Auto Deploy unless you switch the EFI system to BIOS compatibility mode.

- Ensure that the ESXi hosts have network connectivity to vCenter Server and that all port requirements are met. See Required Ports for vCenter Server in *vSphere Installation and Setup*.

- Do not use VLAN tagged networks at the boot NIC. If you want to specify VLAN IDs, you must make sure that the host can reach the DHCP server when the host starts the boot process. Check with your network administrator how VLAN IDs are used in your environment.

- Ensure that you have enough storage for the Auto Deploy repository. The Auto Deploy server uses the repository to store data it needs, including the rules and rule sets you create and the VIBs and image profiles that you specify in your rules.

  Best practice is to allocate 2GB to have enough room for four image profiles and some extra space. Each image profile requires approximately 350MB. Determine how much space to reserve for the Auto Deploy repository by considering how many image profiles you expect to use.

- Obtain the vCenter Server installation media, which include the Auto Deploy installer, or deploy the vCenter Server Appliance. See Installing vCenter Server in *vSphere Installation and Setup*.

- Ensure that a TFTP server is available in your environment. If you require a supported solution, purchase a supported TFTP server from your vendor of choice.

- Obtain administrative privileges to the DHCP server that manages the network segment you want to boot from. You can use a DHCP server already in your environment, or install a DHCP server. For your Auto Deploy setup, replace the gpxelinux.0 file name with undionly.kpxe.vmw-hardwired.
Secure your network as you would for any other PXE-based deployment method. Auto Deploy transfers data over SSL to prevent casual interference and snooping. However, the authenticity of the client or the Auto Deploy server is not checked during a PXE boot. See Chapter 8, “Auto Deploy Best Practices and Security Consideration,” on page 49.

**NOTE** Auto Deploy is not supported with NPIV (N_Port ID Virtualization).

Set up a remote Syslog server. See the vCenter Server and Host Management documentation for Syslog server configuration information. Configure the first host you boot to use the remote syslog server and apply that host’s host profile to all other target hosts. Optionally, install and use the vSphere Syslog Collector, a vCenter Server support tool that provides a unified architecture for system logging and enables network logging and combining of logs from multiple hosts.

Install ESXi Dump Collector and set up your first host so all core dumps are directed to ESXi Dump Collector and apply the host profile from that host to all other hosts. See “Configure ESXi Dump Collector with ESXCLI,” on page 37 and “Set Up ESXi Dump Collector from the Host Profiles Interface,” on page 39.

See Install vSphere ESXi Dump Collector in vSphere Installation and Setup.

Auto Deploy does not support in a pure IPv6 environment because the PXE boot infrastructure requires IPv4.

**Procedure**

1. Install the vSphere Auto Deploy server as part of a vCenter Server installation or standalone on a Windows system, or deploy the vCenter Server Appliance to an ESXi system of your choice.

   **Location** | **Description**
   --- | ---
   **vCenter Server system** | Use the vCenter Server installation media to install Auto Deploy on the same host as the vCenter Server system itself. That vCenter Server system manages all hosts that you provision with this Auto Deploy installation. See Install vSphere Auto Deploy in vSphere Installation and Setup.
   **Windows system** | Use the vCenter Server installation media to install Auto Deploy on a Microsoft Windows system that does not have a vCenter Server system installed. The installer prompts you for a vCenter Server system to register Auto Deploy with. That vCenter Server system manages all hosts that you provision with this Auto Deploy installation. See Install vSphere Auto Deploy in vSphere Installation and Setup.
   **vCenter Server Appliance** | Deploy the vCenter Server Appliance to the ESXi host of your choice. The appliance includes an Auto Deploy server, which is disabled by default. By default, the vCenter Server system on the appliance manages all hosts you provision with the appliance Auto Deploy installation. Other configurations are supported. See “Using Auto Deploy with the VMware vCenter Server Appliance,” on page 42.

2. Configure the TFTP server.
   a. In a vSphere Client connected to the vCenter Server system that Auto Deploy is registered with, click **Home** in the navigation bar and select **Auto Deploy** in the Administration tab to display the Auto Deploy page.
   b. Click **Download TFTP ZIP** to download the TFTP configuration file and unzip the file to the directory in which your TFTP server stores files.

3. Set up your DHCP server to point to the TFTP server on which the TFTP ZIP file is located.
   a. Specify the TFTP Server’s IP address in DHCP option 66 (frequently called `next-server`).
   b. Specify the boot file name, which is `undionly.kpxe.vmware-hardwired` in the DHCP option 67 (frequently called `boot-filename`).
4 Set each host you want to provision with Auto Deploy to network boot or PXE boot, following the manufacturer’s instructions.

5 Locate the image profile you want to use and the depot in which it is located.

In most cases, you point to an image profile VMware makes available in a public depot. If you want to include custom VIBs with the base image, you can use the Image Builder PowerCLI create an image profile and use that image profile. See the Image Builder PowerCLI documentation.

6 Write a rule that assigns an image profile to hosts.

7 (Optional) You can use your own Certificate Authority (CA) by replacing the OpenSSL certificate (rbd-ca.crt) and the OpenSSL private key (rbd-ca.key) with your own certificate and key file.

- On Windows, the files are in the SSL subfolder of the Auto Deploy installation directory. For example, on Windows 7 the default is C:\ProgramData\VMware\VMware vSphere Auto Deploy\ssl.
- On the vCenter Server Appliance, the files are in /etc/vmware-rbd/ssl/.

When you start a host that is set up for Auto Deploy, it contacts the DHCP server and is directed to the Auto Deploy server, which provisions the host with the image specified in the active rule set.

What to do next

- Use the PowerCLI cmdlets to define a rule that assigns an image profile and optional host profile to the host. See “Prepare Your System and Install the Auto Deploy Server,” on page 18.
- Configure the first host your provision to use the storage, networking, and other settings you want for your target hosts to share. Create a host profile for that host and write a rule that assigns both the already tested image profile and the host profile to target hosts.
- If you have to configure host-specific information, set up the host profile of the reference host to prompt for user input. See “Customizing Hosts with Answer Files,” on page 44.

Install vSphere Auto Deploy

Install vSphere Auto Deploy to provision and customize physical hosts by loading the ESXi image directly into memory. You can provision and reprovision hundreds of ESXi hosts efficiently with vCenter Server.

You must install the Auto Deploy feature separately for each instance of vCenter Server that you plan to use the feature with. Auto Deploy is not supported with vCenter Server versions earlier than version 5.0. Auto Deploy supports both IPv4 and IPv6.

Prerequisites

- Verify that you have administrator privileges
- Verify that the host machine has Windows Installer 3.0 or later.
- Verify that the host machine has a supported processor and operating system. Auto Deploy supports the same processors and operating systems as vCenter Server.

See the vCenter Server hardware and software requirements in the Installation and Setup documentation.

Gather the following information to complete the installation:

- The location to install Auto Deploy in, if you are not using the default location.
- The location for the Auto Deploy repository. Do not use a network share for the repository.
(Optional) The maximum size for the Auto Deploy repository. Best practice is to allocate 2GB to have enough room for four image profiles and some extra space. Each image profile requires approximately 350MB. Determine how much space to reserve for the Auto Deploy repository by considering how many image profiles you expect to use. The specified disk must have at least that much free space.

The address and credentials of the vCenter Server that you are installing the Auto Deploy feature for: IP address or name, HTTP port, user name, and password.

The Auto Deploy server port, if you are not using the default setting.

The host name or IP address to identify Auto Deploy on the network.

**Procedure**

1. In the software installer directory, double-click the autorun.exe file to start the installer.
2. Select VMware® Auto Deploy and click Install.
3. Follow the wizard prompts to complete the installation.

**Install PowerCLI and Prerequisite Software**

Before you can run Auto Deploy cmdlets to create and modify the rules and rule sets that govern Auto Deploy behavior, you must install vSphere PowerCLI and all prerequisite software. The Auto Deploy cmdlets are included with the PowerCLI installation.

You install vSphere PowerCLI and prerequisite software on a Microsoft Windows system. See the Microsoft Web site for information about installing the Microsoft software. See the [vSphere PowerCLI Installation Guide](#) for detailed instructions for PowerCLI installation.

**Procedure**

1. Verify that Microsoft .NET 2.0 is installed, or install it from the Microsoft Web site following the instructions on that Web site.
2. Verify that Microsoft Powershell 2.0 is installed, or install it from the Microsoft Web site following the instructions on that Web site.
3. Install vSphere vSphere PowerCLI, which includes the Auto Deploy cmdlets.

**What to do next**

Review “Using Auto Deploy Cmdlets,” on page 21. If you are new to PowerCLI, read the PowerCLI documentation.

Use Auto Deploy cmdlets and other PowerCLI cmdlets and PowerShell cmdlets to manage Auto Deploy rules and rule sets. Use `Get-Help <cmdlet_name>` at any time for command-line help.

**Using Auto Deploy Cmdlets**

Auto Deploy cmdlets are implemented as Microsoft PowerShell cmdlets and included in vSphere PowerCLI. Users of Auto Deploy cmdlets can take advantage of all PowerCLI features.

Experienced PowerShell users can use Auto Deploy cmdlets just like other PowerShell cmdlets. If you are new to PowerShell and PowerCLI, the following tips might be helpful.

You can type cmdlets, parameters, and parameter values in the PowerCLI shell.

- Get help for any cmdlet by running `Get-Help cmdlet_name`.
- Remember that PowerShell is not case sensitive.
- Use tab completion for cmdlet names and parameter names.
Format any variable and cmdlet output by using `Format-List` or `Format-Table` or their short forms `fl` or `ft`. See `Get-Help Format-List`.

**Passing Parameters by Name**

You can pass in parameters by name in most cases and surround parameter values that contain spaces or special characters with double quotes.

```powershell
Copy-DeployRule -DeployRule testrule -ReplaceItem MyNewProfile
```

Most examples in the documentation pass in parameters by name.

**Passing Parameters as Objects**

You can pass parameters as objects if you want to do scripting and automation. Passing in parameters as objects is useful with cmdlets that return multiple objects and with cmdlets that return a single object. Consider the following example.

1. Bind the object that encapsulates rule set compliance information for a host to a variable.
   ```powershell
   $tr = Test-DeployRuleSetCompliance MyEsxi42
   ```
2. Display the `itemlist` property of the object to see the difference between what is in the rule set and what the host is currently using.
   ```powershell
   $tr.itemlist
   ```
3. Remediate the host to use the revised rule set by passing the object to a call to `Repair-DeployRuleSetCompliance`.
   ```powershell
   Repair-DeployRuleSetCompliance $tr
   ```

The example remediates the host the next time you boot the host.

**Setting Properties to Support Remote Signing**

For security reasons, Windows PowerShell supports an execution policy feature. It determines whether scripts are allowed to run and whether they must be digitally signed. By default, the execution policy is set to `Restricted`, which is the most secure policy. If you want to run scripts or load configuration files, you can change the execution policy by using the `Set-ExecutionPolicy` cmdlet. To do this, type the following in the vSphere PowerCLI console window.

```powershell
Set-ExecutionPolicy RemoteSigned
```

If the command is successful, you can run scripts and load configuration files. For more information about the execution policy and digital signing in Windows PowerShell, use the following command.

```powershell
Get-Help About_Signing
```

**Set Up Bulk Licensing**

You can use the vSphere Client or ESXi Shell to specify individual license keys, or you can set up bulk licensing by using PowerCLI cmdlets. Bulk licensing works for all ESXi hosts, but is especially useful for hosts provisioned with Auto Deploy.

The following example assigns licenses to all hosts in a data center. You can also associate licenses with hosts and clusters.

The following example is for advanced PowerCLI users who know how to use PowerShell variables.

**Prerequisites**

Assigning license keys through the vSphere Client or assigning licensing by using PowerCLI cmdlets function differently.

**Assign license keys with vSphere Client**
You can assign license keys to a host when you add the host to the vCenter Server system or when the host is managed by a vCenter Server system.

**Assign license keys with LicenseDataManager PowerCLI**
You can specify a set of license keys to be added to a set of hosts. The license keys are added to the vCenter Server database. Each time a host is added to the vCenter Server system or reconnects to the vCenter Server system, the host is assigned a license key. A license key that is assigned through the PowerCLI is treated as a default license key. When an unlicensed host is added or reconnected, it is assigned the default license key. If a host is already licensed, it keeps its license key.

**Procedure**

1. Connect to the vCenter Server system you want to use and bind the associated license manager to a variable.
   ```powershell
   Connect-VIServer -Server 192.XXX.X.XX -User username -Password password
   $licenseDataManager = Get-LicenseDataManager
   ```

2. Run a cmdlet that retrieves the datacenter in which the hosts for which you want to use the bulk licensing feature are located.
   ```powershell
   $hostContainer = Get-Datacenter -Name Datacenter-X
   ```
   You can also run a cmdlet that retrieves a cluster to use bulk licensing for all hosts in a cluster, or retrieves a folder to use bulk licensing for all hosts in a folder.

3. Create a new `LicenseData` object and a `LicenseKeyEntry` object with associated type ID and license key.
   ```powershell
   $licenseData = New-Object VMware.VimAutomation.License.Types.LicenseData
   $licenseKeyEntry = New-Object Vmware.VimAutomation.License.Types.LicenseKeyEntry
   $licenseKeyEntry.TypeId = "vmware-vsphere"
   $licenseKeyEntry.LicenseKey = "XXXXX-XXXXX-XXXXX-XXXXX-XXXXX"
   ```

4. Associate the `LicenseKeys` attribute of the `LicenseData` object you created in step 3 with the `LicenseKeyEntry` object.
   ```powershell
   $licenseData.LicenseKeys += $licenseKeyEntry
   ```

5. Update the license data for the data center with the `LicenseData` object and verify that the license is associated with the host container.
   ```powershell
   $licenseDataManager.UpdateAssociatedLicenseData($hostContainer.Uid, $licenseData)
   $licenseDataManager.QueryAssociatedLicenseData($hostContainer.Uid)
   ```

6. Provision one or more hosts with Auto Deploy and assign them to the data center or to the cluster that you assigned the license data to.

7. Verify that the host is successfully assigned to the default license `XXXXX-XXXXX-XXXXX-XXXXX-XXXXX`.
   a. Using a vSphere Client, log in to the vCenter Server system.
   b. Navigate to the **Configuration > License Features** tab for the host and check that the correct license is displayed.

All hosts that you assigned to the data center are now licensed automatically.
You can use Auto Deploy PowerCLI cmdlets to create rules that associate hosts with image profiles, host profiles, and a location on the vCenter Server target. You can also update hosts by testing rule compliance and repairing compliance issues.

This chapter includes the following topics:

- “Assign an Image Profile to Hosts,” on page 25
- “Assign a Host Profile to Hosts,” on page 27
- “Assign a Host to a Folder or Cluster,” on page 28
- “Test and Repair Rule Compliance,” on page 28

Assign an Image Profile to Hosts

Before you can provision a host, you must create rules that assign an image profile to each host that you want to provision by using Auto Deploy.

Prerequisites

- Install VMware PowerCLI and all prerequisite software.
- If you encounter problems running PowerCLI cmdlets, consider changing the execution policy. See “Using Auto Deploy Cmdlets,” on page 21.

Procedure

1. Run the Connect-VIServer PowerCLI cmdlet to connect to the vCenter Server system that Auto Deploy is registered with.
   
   ```powershell
   Connect-VIServer 192.XXX.X.XX
   ```
   
   In a production environment, make sure no server certificate warnings result. In a development environment, you can ignore the warning.

2. Determine the location of a public software depot, or define a custom image profile using the Image Builder PowerCLI.
3 Run `Add-EsxSoftwareDepot` to add the software depot that contains the image profile to the PowerCLI session.

<table>
<thead>
<tr>
<th>Depot Type</th>
<th>Cmdlet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote depot</td>
<td>Run <code>Add-EsxSoftwareDepot depot_url</code></td>
</tr>
</tbody>
</table>
| ZIP file       | a Download the ZIP file to a local file path.  
|                | b Run                                        |
|                | Run `Add-EsxSoftwareDepot C:\file_path\my_offline_depot.zip` |

4 In the depot, find the image profile you want to use by running the `Get-EsxImageProfile` cmdlet.

By default, the ESXi depot includes one base image profile that includes VMware tools and has the string full in its name, and one base image profile that does not include VMware tools.

5 Define a rule in which hosts with certain attributes, for example a range of IP addresses, are assigned to the image profile.

```
New-DeployRule -Name "testrule" -Item "My Profile25" -Pattern "vendor=Acme,Zven", "ipv4=192.XXX.1.10-192.XXX.1.20"
```

Double quotes are required if a name contains spaces, optional otherwise. Specify `-AllHosts` instead of a pattern to apply the item to all hosts.

The cmdlet creates a rule named `testrule`. The rule assigns the image profile named `My Profile25` to all hosts with a vendor of Acme or Zven that also have an IP address in the specified range.

6 Add the rule to the rule set.

```
Add-DeployRule testrule
```

By default, the rule is added to both the working rule set and the active rule set. If you use the `-NoActivate` parameter, the working rule set does not become the active rule set.

When the host boots from gPXE, it reports attributes of the machine to the console. Use the same format of the attributes when writing deploy rules.

```
******************************************************************
* Booting through VMware AutoDeploy...
* Machine attributes:
* . vendor=VMware, Inc.
* . asset=No Asset Tag
* . domain=
* . serial=VMware-XX XX XX XX XX...
* . uuid=XXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXX
* . hostname=myhost.mycompany.com
* . ipv4=NN.NN.NNN.NNN
* . model=VMware Virtual Platform
* . mac=NN:NN:NN:NN:NN

******************************************************************
```

What to do next

- For hosts already provisioned with Auto Deploy, perform the compliance testing and repair operations to provision them with the new image profile. See “Test and Repair Rule Compliance,” on page 28.
- Turn on unprovisioned hosts to provision them with the new image profile.
Assign a Host Profile to Hosts

Auto Deploy can assign a host profile to one or more hosts. The host profile might include information about storage configuration, network configuration, or other characteristics of the host. If you add a host to a cluster, that cluster's host profile is used.

The following procedure explains how to write a rule that assigns a host profile to hosts. To assign the host profiles to hosts already provisioned with Auto Deploy, you must also perform a test and repair cycle. See “Test and Repair Rule Compliance,” on page 28.

In many cases, you assign a host to a cluster instead of specifying a host profile explicitly. The host uses the host profile of the cluster.

Prerequisites

- Install vSphere PowerCLI and all prerequisite software.
- Export the host profile that you want to use.
- If you encounter problems running PowerCLI cmdlets, consider changing the execution policy. See “Using Auto Deploy Cmdlets,” on page 21.

Procedure

1. Run the `Connect-VIServer` PowerCLI cmdlet to connect to the vCenter Server system that Auto Deploy is registered with.

   ```powershell
   Connect-VIServer 192.XXX.X.XX
   ```

   The cmdlet might return a server certificate warning. In a production environment, make sure no server certificate warnings result. In a development environment, you can ignore the warning.

2. In the vSphere Client, select View > Management > Host Profiles to display the Host Profiles panel and export the host profile that you want to use from there.

3. Find the name of the host profile by running `Get-VMhostProfile`, passing in the server on which the host profile is located.

4. At the PowerCLI prompt, define a rule in which hosts with certain attributes, for example a range of IP addresses, are assigned to the host profile.

   ```powershell
   New-DeployRule -Name "testrule2" -Item my_host_profile -Pattern "vendor=Acme,Zven", "ipv4=192.XXX.1.10-192.XXX.1.20"
   ```

   The specified item is assigned to all hosts with the specified attributes. This example specifies a rule named testrule2. The rule assigns the specified host profile my_host_profile to all hosts with an IP address inside the specified range and with a manufacturer of Acme or Zven.

5. Add the rule to the rule set.

   ```powershell
   Add-DeployRule testrule2
   ```

   By default, the working rule set becomes the active rule set, and any changes to the rule set become active when you add a rule. If you use the NoActivate parameter, the working rule set does not become the active rule set.

What to do next

- Upgrade existing hosts to use the new host profile by performing compliance test and repair operations on those hosts. See “Test and Repair Rule Compliance,” on page 28.
- Turn on unprovisioned hosts to provision them with the host profile.
Assign a Host to a Folder or Cluster

Auto Deploy can assign a host to a folder or cluster. When the host boots, Auto Deploy adds it to the specified location on the vCenter Server. Hosts assigned to a cluster inherit the cluster's host profile.

The following procedure explains how to write a rule that assigns a host to a folder or cluster. To assign a host already provisioned with Auto Deploy to a new folder or cluster, you must also perform a test and repair cycle. See “Test and Repair Rule Compliance,” on page 28.

Prerequisites

- Install VMware PowerCLI and all prerequisite software.
- If you encounter problems running PowerCLI cmdlets, consider changing the execution policy. See “Using Auto Deploy Cmdlets,” on page 21.

Procedure

1. Run the `Connect-VIServer` PowerCLI cmdlet to connect to the vCenter Server system that Auto Deploy is registered with.

   ```bash
   Connect-VIServer 192.XXX.X.XX
   ```

   The cmdlet might return a server certificate warning. In a production environment, make sure no server certificate warnings result. In a development environment, you can ignore the warning.

2. Define a rule in which hosts with certain attributes, for example a range of IP addresses, are assigned to a folder or a cluster.

   ```bash
   New-DeployRule -Name "testrule3" -Item "my folder" -Pattern "vendor=Acme,Zven", "ipv4=192.XXX.1.10-192.XXX.1.20"
   ```

   This example passes in the folder by name. You can instead pass in a folder, cluster, or datacenter object that you retrieve with the `Get-Folder`, `Get-Cluster`, or `Get-Datacenter` cmdlet.

3. Add the rule to the rule set.

   ```bash
   Add-DeployRule testrule3
   ```

   By default, the working rule set becomes the active rule set, and any changes to the rule set become active when you add a rule. If you use the `NoActivate` parameter, the working rule set does not become the active rule set.

What to do next

- Upgrade existing hosts to be added to the specified vCenter Server location by performing compliance test and repair operations on those hosts. See “Test and Repair Rule Compliance,” on page 28.
- Turn on unprovisioned hosts to add them to the specified vCenter Server location.

Test and Repair Rule Compliance

When you add a rule to the Auto Deploy rule set or make changes to one or more rules, hosts are not updated automatically. Auto Deploy applies the new rules only when you test their rule compliance and perform remediation.

This task assumes that your infrastructure includes one or more ESXi hosts provisioned with Auto Deploy, and that the host on which you installed VMware PowerCLI can access those ESXi hosts.

Prerequisites

- Install VMware PowerCLI and all prerequisite software.
If you encounter problems running PowerCLI cmdlets, consider changing the execution policy. See “Using Auto Deploy Cmdlets,” on page 21.

Procedure
1. Use PowerCLI to check which Auto Deploy rules are currently available.

   `Get-DeployRule`

   The system returns the rules and the associated items and patterns.

2. Make a change to one of the available rules, for example, you might change the image profile and the name of the rule.

   `Copy-DeployRule -DeployRule testrule -ReplaceItem MyNewProfile`

   You cannot edit a rule already added to a rule set. Instead, you copy the rule and replace the item or pattern you want to change.

3. Verify that the host that you want to test rule set compliance for is accessible.

   `Get-VMHost -Name MyEsxi42`

4. Run the cmdlet that tests rule set compliance for the host, and bind the return value to a variable for later use.

   `$tr = Test-DeployRuleSetCompliance MyEsxi42`

5. Examine the differences between what is in the rule set and what the host is currently using.

   `$tr.itemlist`

   The system returns a table of current and expected items.

<table>
<thead>
<tr>
<th>CurrentItem</th>
<th>ExpectedItem</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Profile 25</td>
<td>MyProfileUpdate</td>
</tr>
</tbody>
</table>

6. Remediate the host to use the revised rule set the next time you boot the host.

   `Repair-DeployRuleSetCompliance $tr`

What to do next

If the rule you changed specified the inventory location, the change takes effect when you repair compliance. For all other changes, boot your host to have Auto Deploy apply the new rule and to achieve compliance between the rule set and the host.
vSphere Auto Deploy can provision hundreds of physical hosts with ESXi software. You can provision hosts that did not previously run ESXi software (first boot), reboot hosts, or reprovision hosts with a different image profile, host profile, or folder or cluster location.

The Auto Deploy process differs depending on the state of the host and on the changes that you want to make.

This chapter includes the following topics:

- “Provision a Host (First Boot),” on page 31
- “Reprovisioning Hosts,” on page 32

Provision a Host (First Boot)

Provisioning a host that has never been provisioned with Auto Deploy (first boot) differs from subsequent boot processes. You must prepare the host, define the image using the Image Builder PowerCLI, and fulfill all other prerequisites before you can provision the host.

Prerequisites

- Make sure your host meets the hardware requirements for ESXi hosts.
  
  See ESXi Hardware Requirements in the vSphere Installation and Setup documentation.

- Prepare the system for vSphere Auto Deploy (see Chapter 3, “Preparing for vSphere Auto Deploy,” on page 17).

- Write rules that assign an image profile to the host and optionally assign a host profile and a vCenter Server location to the host. See Chapter 4, “Managing Auto Deploy with PowerCLI Cmdlets,” on page 25.

  When setup is complete, the Auto Deploy server and PowerCLI are installed, DHCP setup is complete, and rules for the host that you want to provision are in the active rule set.

Procedure

1. Turn on the host.

   The host contacts the DHCP server and downloads gPXE from the location the server points it to. Next, the Auto Deploy server provisions the host with the image specified by the rule engine. The Auto Deploy server might also apply a host profile to the host if one is specified in the rule set. Finally, Auto Deploy adds the host to the vCenter Server system that is specified in the rule set.
2  (Optional) If Auto Deploy applies a host profile that requires user input such as an IP address, the host is placed in maintenance mode. In the vSphere Client, check the answer file or reapply the host profile and provide the user input when prompted.

The information is stored in an answer file that is associated with the host.

After the first boot process, the host is running and managed by a vCenter Server system. The vCenter Server stores the host’s image profile, host profile, and location information.

You can now reboot the host as needed. Each time you reboot, the host is reprovisioned by the vCenter Server system.

What to do next

Reprovision hosts as needed. See “Reprovisioning Hosts,” on page 32.

If you want to change the image profile, host profile, or location of the host, update the rules and perform a test and repair compliance operation. See “Test and Repair Rule Compliance,” on page 28.

Reprovisioning Hosts

vSphere Auto Deploy supports multiple reprovisioning options. You can perform a simple reboot or reprovision with a different image or a different host profile.

A first boot using Auto Deploy requires that you set up your environment and add rules to the rule set. See Chapter 3, “Preparing for vSphere Auto Deploy,” on page 17.

The following reprovisioning operations are available.

- Simple reboot.
- Reboot of hosts for which the user answered questions during the boot operation.
- Reprovision with a different image profile.
- Reprovision with a different host profile.

Reprovisioning Hosts with Simple Reboot Operations

A simple reboot of a host that is provisioned with Auto Deploy requires only that all prerequisites are still met. The process uses the previously assigned image profile, host profile, and vCenter Server location.

Setup includes DHCP server setup, writing rules, and making an image available to the Auto Deploy infrastructure.

Prerequisites

Make sure the setup you performed during the first boot operation is in place.

Procedure

1  Check that the image profile and host profile for the host are still available, and that the host has the identifying information (asset tag, IP address) it had during previous boot operations.

2  Place the host in maintenance mode.

<table>
<thead>
<tr>
<th>Host Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host is part of a DRS cluster</td>
<td>VMware DRS migrates virtual machines to appropriate hosts when you place the host in maintenance mode.</td>
</tr>
<tr>
<td>Host is not part of a DRS cluster</td>
<td>You must migrate all virtual machines to different hosts and place each host in maintenance mode.</td>
</tr>
</tbody>
</table>

3  In the vSphere Client, right-click the host and choose Reboot.
The host shuts down. When the host reboots, it uses the image profile that the Auto Deploy server provides. The Auto Deploy server also applies the host profile stored on the vCenter Server system.

**Reprovision a Host with a New Image Profile**

You can reprovision the host with a new image profile, host profile, or vCenter Server location by changing the rule for the host and performing a test and repair operation.

Several options for reprovisioning hosts exist.

- If the VIBs that you want to use support live update, you can use an `esxcli software vib` command. In that case, you must also update the rule set to use an image profile that includes the new VIBs upon reboot.
- During testing, you can apply an image profile to an individual host with the `Apply-EsxImageProfile` cmdlet and reboot the host so the change takes effect. The `Apply-EsxImageProfile` cmdlet updates the association between the host and the image profile but does not install VIBs on the host.
- In all other cases, use this procedure.

**Prerequisites**

- Create the image profile you want to boot the host with. Use the Image Builder PowerCLI. See “Using vSphere ESXi Image Builder CLI” in the *vSphere Installation and Setup* documentation.
- Make sure that the setup that you performed during the first boot operation is in place.

**Procedure**

1. At the PowerShell prompt, run the `Connect-VIServer` PowerCLI cmdlet to connect to the vCenter Server system that Auto Deploy is registered with.

   ```powershell
   Connect-VIServer myVCServer
   ```

   The cmdlet might return a server certificate warning. In a production environment, make sure no server certificate warnings result. In a development environment, you can ignore the warning.

2. Determine the location of a public software depot that contains the image profile that you want to use, or define a custom image profile with the Image Builder PowerCLI.

3. Run `Add-EsxSoftwareDepot` to add the software depot that contains the image profile to the PowerCLI session.

<table>
<thead>
<tr>
<th>Depot Type</th>
<th>Cmdlet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote depot</td>
<td>Run <code>Add-EsxSoftwareDepot depot_url</code></td>
</tr>
<tr>
<td>ZIP file</td>
<td>a Download the ZIP file to a local file path or create a mount point local to the PowerCLI machine.</td>
</tr>
<tr>
<td></td>
<td>b Run <code>Add-EsxSoftwareDepot C:\file_path\my_offline_depot.zip</code>.</td>
</tr>
</tbody>
</table>

4. Run `Copy-DeployRule` and specify the `ReplaceItem` parameter to change the rule that assigns an image profile to hosts.

   The following cmdlet replaces the current image profile that the rule assigns to the host with the `my_new_imageprofile` profile. After the cmdlet completes, `myrule` assigns the new image profile to hosts. The old version of `myrule` is renamed and hidden.

   ```powershell
   Copy-DeployRule myrule -ReplaceItem my_new_imageprofile
   ```

5. Test and repair rule compliance for each host that you want to deploy the image to.

When you reboot hosts after compliance repair, Auto Deploy provisions the hosts with the new image profile.

**Applying a Host Profile to Prompt for User Input**

If a host required user input during a previous boot, the answers are saved with the vCenter Server in an answer file. If you want to prompt the user for new information, you reapply the host profile.

**Prerequisites**

Attach a host profile that prompts for user input to the host.

**Procedure**

1. Place the host in maintenance mode. Migrate all virtual machines to different hosts, and place the host into maintenance mode.

<table>
<thead>
<tr>
<th>Host Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host is part of a DRS cluster</td>
<td>VMware DRS migrates virtual machines to appropriate hosts when you place the host in maintenance mode.</td>
</tr>
<tr>
<td>Host is not part of a DRS cluster</td>
<td>You must migrate all virtual machines to different hosts and place each host in maintenance mode.</td>
</tr>
</tbody>
</table>

2. In the vSphere Client, choose Host Profiles > Apply Profile and choose the host profile that requires user input when prompted.

3. When prompted, provide the user input.

You can now direct the host to exit maintenance mode.

The user input information is saved in an answer file. The next time you boot, the answer file information is applied to the host. One answer file per host is available.
Setting Up an Auto Deploy Reference Host

In an environment where no state is stored on the host, a reference host helps you set up multiple hosts with the same configuration. You configure the reference host with the logging, coredump, and other settings that you want, save the host profile, and write a rule that applies the host profile to other hosts as needed.

You can configure the storage, networking, and security settings on the reference host and set up services such as syslog and NTP.

This chapter includes the following topics:

- “Understanding Reference Host Setup,” on page 35
- “Configuring an Auto Deploy Reference Host,” on page 37
- “Configure ESXi Dump Collector with ESXCLI,” on page 37
- “Configure Host Profiles for an Auto Deploy Reference Host,” on page 38

Understanding Reference Host Setup

A well-designed reference host connects to all services such as Syslog, NTP, and so on. The reference host might also include setup of security, storage, networking, and ESXi Dump Collector.

The exact setup of your reference host depends on your environment, but you might consider the following customization.

**NTP Server Setup**

When you collect logging information in large environments, you must make sure that log times are coordinated. Set up the reference host to use the NTP server in your environment that all hosts can share. You can specify an NTP server with the `vicfg-ntp` command. You can start and stop the NTP service for a host with the `vicfg-ntp` command or the vSphere Client.

**Syslog Server Setup**

All ESXi hosts run a syslog service (`vmsyslogd`), which logs messages from the VMkernel and other system components to a file. You can specify the log host and manage the log location, rotation, size, and other attributes with the `esxcli system syslog` command or with the vSphere Client. Setting up logging on a remote host is especially important for hosts provisioned with Auto Deploy that have no local storage. You can optionally install the vSphere Syslog Collector to collect logs from all hosts.

**Core Dump Setup**

You can set up your reference host to send core dumps to a shared SAN LUN, or you can install ESXi Dump Collector in your environment and set up the reference host to use ESXi Dump Collector. See “Configure ESXi Dump Collector with ESXCLI,” on page 37. You can either install ESXi Dump
Collector by using the vCenter Server installation media or use the ESXi Dump Collector that is included in the vCenter Server Appliance. After setup is complete, VMkernel memory is sent to the specified network server when the system encounters a critical failure.

**Security Setup**

In most deployments, all hosts that you provision with Auto Deploy must have the same security settings. Make any customization in your reference host. You can, for example, set up the firewall to allow certain services access to the ESXi system. See the *vSphere Security* documentation. Security setup includes shared user access settings for all hosts. You can achieve unified user access by setting up your reference host for Microsoft Active Directory. If you set up Active Directory by using host profiles, the passwords are not protected. Use the vSphere Authentication Service to set up Active Directory to avoid exposing the Active Directory password.

**Networking and Storage Setup**

If you reserve a set of networking and storage resources for use by hosts provisioned with Auto Deploy, you can set up your reference host to use those resources.

In very large deployments, the reference host setup supports an Enterprise Network Manager, which collects all information coming from the different monitoring services in the environment.

"Configuring an Auto Deploy Reference Host," on page 37 explains how to perform this setup.
**Configuring an Auto Deploy Reference Host**

vSphere allows you to configure a reference host by using the vSphere Client, by using vCLI, or by using host profiles.

To set up a host profile, you can use the approach that suits you best.

- **vSphere Client**

  The vSphere Client supports setup of networking, storage, security, and most other aspects of an ESXi host. You can completely set up your environment and export the host profile for use by Auto Deploy.

- **vSphere Command-Line Interface**

  You can use vCLI commands for setup of many aspects of your host. vCLI is especially suitable for configuring some of the services in the vSphere environment. Commands include `vicfg-ntp` (set up an NTP server), `esxcli system syslog` (set up a syslog server), and `vicfg-route` (set up the default route). See “Configure ESXi Dump Collector with ESXCLI,” on page 37.

- **Host Profiles Interface**

  You can either set up a host with vSphere Client or vCLI and save the host profile for that host, or you can configure the host profiles directly with the Host Profiles interface in the vSphere Client. See “Configure Host Profiles for an Auto Deploy Reference Host,” on page 38.

**Configure ESXi Dump Collector with ESXCLI**

A core dump is the state of working memory in the event of host failure. By default, a core dump is saved to the local disk. You can use ESXi Dump Collector to keep core dumps on a network server for use during debugging. ESXi Dump Collector is especially useful for Auto Deploy, but is supported for any ESXi host. ESXi Dump Collector supports other customization, including sending core dumps to the local disk.

**Prerequisites**

Install ESXi Dump Collector, a support tool that is included with the vCenter Server `autorun.exe` application and that is also included in the vCenter Server Appliance.

Install vCLI if you want to configure the host to use ESXi Dump Collector. In troubleshooting situations, you can use ESXCLI in the ESXi Shell instead.

**Procedure**

1. Set up an ESXi system to use ESXi Dump Collector by running `esxcli system coredump` in the local ESXi shell or by using vCLI.

   ```plaintext
   esxcli system coredump network set --interface-name vmk0 --server-ipv4 10xx.xx.xx.xx --server-port 6500
   ```

   You must specify a VMkernel NIC and the IP address and optional port of the server to send the core dumps to. If you configure an ESXi system that is running inside a virtual machine that is using a vSphere standard switch, you must choose a VMkernel port that is in promiscuous mode. ESXi Dump Collector is not supported on vSphere distributed switches.

2. Enable ESXi Dump Collector.

   ```plaintext
   esxcli system coredump network set --enable true
   ```

3. (Optional) Check that ESXi Dump Collector is configured correctly.

   ```plaintext
   esxcli system coredump network get
   ```

The host on which you have set up ESXi Dump Collector is set up to send core dumps to the specified server by using the specified VMkernel NIC and optional port.
What to do next

- Write a rule that applies the host profile to all hosts that you want to provision with the settings that you specified in the reference host (see “Assign a Host Profile to Hosts,” on page 27).
- For hosts that are already provisioned with Auto Deploy, perform the test and repair compliance operations to provision them with the new host profile. See “Test and Repair Rule Compliance,” on page 28.
- Turn on unprovisioned hosts to provision them with the new host profile.

Configure Host Profiles for an Auto Deploy Reference Host

You can set up host profiles in a reference host and apply those host profile settings to all other hosts provisioned with vSphere Auto Deploy. You can either configure the reference host and export the host profile or, for small changes, edit the host profiles directly.

Prerequisites

Install a vSphere Client to access the vCenter Server system that manages the host that you want to use as a reference host.

Procedure

1. Use a vSphere Client to connect to the vCenter Server system.
2. Select the host and select View > Management > Host Profiles.
3. For a new profile, click Create Profile, or right-click a profile that you want to modify and select Edit Profile.
4. In the Edit Profile dialog, select the fields for the policy that you want to set up.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESXi Dump Collector</td>
<td>Set up ESXi Dump Collector with the esxcli system coredump command and save the host profile (best practice), or configure the host profile directly.</td>
</tr>
<tr>
<td>Syslog</td>
<td>Set up syslog for the host with the esxcli system syslog command. Save the host profile (best practice) or configure the host profile directly. See “Set Up Syslog from the Host Profiles Interface,” on page 39.</td>
</tr>
<tr>
<td>NTP</td>
<td>Use the vicfg-ntp vCLI command or the vSphere Client to set up a host. If you use the vSphere Client to start the NTP Server, make sure the startup policy for the NTP Daemon is set appropriately.</td>
</tr>
<tr>
<td></td>
<td>a. In the vSphere Client, select the Configuration tab and click Time Configuration in the Software panel.</td>
</tr>
<tr>
<td></td>
<td>b. Click Properties, click the NTP Client Enabled check box and click Options.</td>
</tr>
<tr>
<td></td>
<td>c. Select the Start and Stop with Host button.</td>
</tr>
<tr>
<td>Security</td>
<td>Set up the Firewall configuration, Security configuration, User configuration, and User Group configuration for the reference host with the vSphere Client or with vCLI commands.</td>
</tr>
<tr>
<td>Networking and Storage</td>
<td>Set up the Networking and Storage policies for the reference host with the vSphere Client or vCLI command.</td>
</tr>
</tbody>
</table>

5. Click OK to save the host profile settings.

What to do next

Write a rule that applies the host profile to all hosts that you want to provision with the settings that you specified in the reference host (see “Assign a Host Profile to Hosts,” on page 27), and perform a test and repair compliance operation.
Set Up ESXi Dump Collector from the Host Profiles Interface

You can set up ESXi Dump Collector for a reference host with esxcli or directly in the Host Profiles panels of the vSphere Client. You can export the host profile and write a rule that applies the profile to all hosts provisioned with Auto Deploy.

Best practice is to set up hosts to use ESXi Dump Collector with the esxcli system coredump command and save the host profile (see “Configure ESXi Dump Collector with ESXCLI” on page 37). In some situations, setting up ESXi Dump Collector from the Host Profiles interface is an alternative.

Prerequisites

You must have a host that has sufficient storage capability for core dumps from multiple hosts provisioned with vSphere Auto Deploy.

Procedure

1. Select Network Configuration.
2. Select Network Coredump Settings and click Edit.
3. Specify the server port and IP address and the host NIC to use and click the check box to enable ESXi Dump Collector.
4. Click OK to save the host profile settings.

What to do next

- Write a rule that applies the host profile to all hosts that you want to provision with the settings that you specified in the reference host (see “Assign a Host Profile to Hosts,” on page 27).
- For hosts already provisioned with Auto Deploy, perform the compliance testing and repair operations to provision them with the new host profile. See “Test and Repair Rule Compliance,” on page 28.
- Turn on unprovisioned hosts to provision them with the new host profile.

Set Up Syslog from the Host Profiles Interface

Hosts provisioned with Auto Deploy usually do not have sufficient local storage to save system logs. You can specify a remote syslog server for those hosts by setting up a reference host, saving the host profile, and applying that host profile to other hosts as needed.

Best practice is to set up the syslog server on the reference host with the vSphere Client or the esxcli system syslog command and save the host profile. In some situations, setting up syslog from the Host Profiles interface is an alternative.

Prerequisites

If you intend to use a remote syslog host, set up that host before you customize host profiles.

Procedure

1. Use a vSphere Client to connect to the vCenter Server system.
2. Select the host and select View > Management > Host Profiles.
3. For a new profile, click Create Profile, or right-click a profile you want to modify and select Edit Profile.
4. In the Edit Profile dialog, set up the syslog server host profile.
   - If you configure a remote syslog server with the vSphere Client or the esxcli system syslog command before you edit host profiles, you can change the remote server and all other syslog options.
     - Select Advanced configuration option.
Select the syslog server settings that you want to use for the hosts provisioned with Auto Deploy.

- If you do not configure a remote syslog server before you edit host profiles, you must add an advanced option.
  
  a. Right-click Advanced configuration option and select Add Profile.
  
  b. Open the Advanced configuration option folder and scroll to the bottom.
  
  c. Click Option Profile, click Edit, and select Configure a fixed option.
  
  d. Specify Syslog.global.logHost as the option name and the name or IP address of the syslog server as the option value.

You must specify a valid syslog server or you cannot save the host profile policy.

5. Click OK to save the host profile settings.

**What to do next**

- Turn on unprovisioned hosts to provision them with the new image profile.

**Set Up Networking for Your Auto Deploy Host**

You can set up networking for your Auto Deploy reference host and apply the host profile to all other hosts to guarantee a fully functional networking environment.

**Prerequisites**

Provision the host you wish to use as your reference host with an ESXi image by using Auto Deploy.

**Procedure**

1. In the vSphere Client select Configuration, click Networking in the Hardware panel, and verify that vmk0 is connected to the Management Network.

2. If you are using virtual switches and not vSphere Distributed Switch, do not add other VMkernel NICs to vSwitch0.

3. After the reference host is completely configured, reboot the system to verify that vmk0 is connected to the Management Network.

4. Export the host profile.

**What to do next**

- Write a rule that applies the host profile to all hosts that you want to provision with the settings that you specified in the reference host (see “Assign a Host Profile to Hosts,” on page 27).

- For hosts already provisioned with Auto Deploy, perform the compliance testing and repair operations to provision them with the new host profile. See “Test and Repair Rule Compliance,” on page 28.

- Turn on unprovisioned hosts to provision them with the new host profile.
In most cases, you manage your Auto Deploy environment by preparing system setup, writing rules, and provisioning hosts. In some cases, you might perform advanced management tasks such as reregistering the Auto Deploy server or assigning a static IP address to each host.

This chapter includes the following topics:

- “Reregister Auto Deploy,” on page 41
- “Use Hosts with Static IP Addresses,” on page 42
- “Using Auto Deploy with the VMware vCenter Server Appliance,” on page 42
- “Customizing Hosts with Answer Files,” on page 44

### Reregister Auto Deploy

If the IP address of the vCenter Server changes, you must reregister Auto Deploy.

Regardless of whether you are using the vCenter Server Appliance or a vCenter Server system installed on Windows, you must reregister Auto Deploy if the vCenter Server IP address changes.

**Procedure**

- Perform the reregistration task depending on the operating system.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Task</th>
</tr>
</thead>
</table>
| **Windows**                       | a Edit the setup file located at `c:\ProgramData\VMware\VMware vCenter Auto Deploy\vmconfig-autodeploy.xml` and specify the new IP address. You do not have to edit the file if you reregister for other reasons than a new IP address.  
|                                   | b Run the `autodeploy-register.exe` command-line tool, specifying all required options.  
|                                   |   `autodeploy-register.exe -R -a vCenter-IP -p vCenter-Port -u user_name -w password -s setup-file-path`  
| **VMware vCenter Server Appliance** | Restart the Auto Deploy daemon `/etc/init.d/vmware-rbd-watchdog`. You can start the daemon directly or use the **Start ESXi Services** and **Stop ESXi Services** vCenter Server Appliance buttons. |
Use Hosts with Static IP Addresses

By default, hosts provisioned with Auto Deploy are assigned DHCP addresses by a DHCP server. You can use the Auto Deploy answer file mechanism to assign static IP addresses to hosts.

You can configure your DHCP server to return a fixed IP address for each machine’s MAC address so that the IP address is consistent across boots. See your DHCP server documentation for more information.

Prerequisites
Set up your Auto Deploy environment.

Procedure
1. Boot a host using Auto Deploy.
2. With vSphere Client, connect to the vCenter Server that manages the Auto Deploy host, select the host, and select View > Management > Host Profiles to display the host profile.
3. Select a host, select Edit Profile, and select Networking configuration > Host port group > Management Network > IP address settings > IP address.
4. Select User specified IP address to be used while applying the configuration.
5. Select Networking configuration > DNS configuration > DNS settings and make sure the Flag indicating if DHCP should be used check box is not selected.
6. Export the host profile and modify the rule that assigns a host profile to the hosts for which you want to use a static IP address.
7. In the vSphere Client, apply the host profile to be prompted for the information without rebooting.
   a. Right-click the host, select Host Profiles > Manage Profile, select the profile to attach, and click OK.
   b. Right-click the host and select Enter Maintenance Mode.
   c. Right-click the host and select Host Profiles > Apply Profile.
   d. When prompted, provide the IP address.
   e. Right-click the host and select Exit Maintenance Mode.

The IP address is saved in an answer file. The next time you boot, the answer file information is applied to the host. One answer file per host is available.

Using Auto Deploy with the VMware vCenter Server Appliance

The VMware vCenter Server Appliance is a preconfigured Linux-based virtual machine optimized for running vCenter Server and associated services. The appliance includes an Auto Deploy server that is disabled by default.

You can use Auto Deploy with the vCenter Server Appliance in different ways.

- Use the vCenter Server system on the appliance in conjunction with the Auto Deploy server on the appliance.
- Use the vCenter Server system on the appliance in conjunction with an Auto Deploy server that you install separately on a Windows system.
- Use the Auto Deploy server on the appliance in conjunction with a vCenter Server system that you install on a different vCenter Server appliance.
- Use the Auto Deploy server on the appliance in conjunction with a vCenter Server system that you install separately on a Windows system.
If you want to use the Auto Deploy server on the vCenter Server appliance, you must start the service first. You can start the service from the Services tab of the appliance.

In all cases, you are responsible for setting up your DHCP server. See “Prepare Your System and Install the Auto Deploy Server,” on page 18.

**Note** You can register only one Auto Deploy instance with a vCenter Server system, and only one vCenter Server system with an Auto Deploy server.

### Set Up the vCenter Server Appliance to Use a Standalone Auto Deploy Server

The vCenter Server Appliance includes an Auto Deploy server. You can also use the appliance with a standalone Auto Deploy server.

**Prerequisites**

- Deploy the vCenter Server Appliance.
- Obtain the vCenter Server installation media, which include the Auto Deploy installer.
- Verify that the Windows system that you want to use for Auto Deploy meets the requirements for vCenter Server installation. Auto Deploy has the same requirements.

**Procedure**

1. On the vCenter Server Appliance, unregister the built-in Auto Deploy server from a Linux command prompt.

<table>
<thead>
<tr>
<th>Auto Deploy status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Deploy has never been started on the appliance</td>
<td>Run this command. <code>autodeploy-register --unregister -a localhost -l</code></td>
</tr>
</tbody>
</table>
| Auto Deploy is running on the appliance | Stop Auto Deploy and unregister by running these commands.  
`service vmware-rdb-watchdog stop`  
`chkconfig vmware-rdb-watchdog off`  
`autodeploy-register --unregister -a localhost -l` |

By default, the Auto Deploy daemon is not running.

2. Using the vCenter Server installation media, install Auto Deploy on a Windows system and provide the vCenter Server Appliance information when prompted for the vCenter Server.

Your standalone Auto Deploy installation is now associated with the vCenter Server on the vCenter Server Appliance.

### Set Up Auto Deploy on the vCenter Server Appliance

By default, Auto Deploy on the vCenter Server Appliance is preconfigured to use the vCenter Server system running on the appliance. You can set up Auto Deploy to use a different vCenter Server system.

**Prerequisites**

- Deploy the vCenter Server Appliance.
- Install a vCenter Server system to use with Auto Deploy.

**Procedure**

- At the Linux command prompt on the vCenter Server appliance, specify the target vCenter Server system, and provide the user name and password for the vCenter Server system.

  `autodeploy-register --register -a vcenter-ip -u username -w password`
Customizing Hosts with Answer Files

To customize hosts with shared attributes, you can create a host profile in a reference host. To customize individual hosts, you can set up some fields in the host profile to prompt the user for input for each host. After the user has specified the information, the system generates a host-specific answer file and stores it with the Auto Deploy cache and the vCenter Server host object.

Setting Host Profiles to Prompt for User Input

Host profiles allow you to prespecify information, for example, the storage setup or Syslog setup in a reference host and apply the host profile to a set of target hosts that share the same settings. You can also use host profiles to specify that certain settings are host-dependent. If you do so, the host comes up in maintenance mode when you provision it with Auto Deploy. Apply the host profile or update the answer file to be prompted for input. The system stores your input and uses it the next time the host boots.

**Note** The answer file is not stored in a location or format that administrators can access. Use the Host Profiles UI in the vSphere Client to manage answer files.

When the host profile is set to prompt for user input, you must specify a value in the dialog that appears. An error results if you do not specify a value.

<table>
<thead>
<tr>
<th>Information to Request User Input For</th>
<th>Setting the Host Profile Option</th>
</tr>
</thead>
</table>
| When you apply a host profile on a system that includes a profile for iSCSI, you are prompted for several properties. For many of the properties, a system default is available. For some properties, you must specify a value or an error results. | 1. Select **Storage configuration** and click **iSCSI Initiator Configuration**  
2. If the HBA you want to configure is not in the list, Right-click the folder that corresponds to the initiator you want to configure and select **Add Profile**.  
You have to add a profile, for example, if software iSCSI was not enabled during host profile creation and you want to configure the software iSCSI initiator.  
3. Set up the initiator. For many fields, the user is prompted when you apply the profile. |
| IQN name | If the iSCSI setup uses an IQN name, you are prompted when you apply the host profile. You cannot continue until you provide the name. |
| CHAP information | If you set up iSCSI to require CHAP authentication, you are prompted for CHAP information including the user name and the secret when you apply the host profile. You cannot continue until you provide the name. |
### Table 7-2. Host Profile Options that Prompt for Storage User Input

<table>
<thead>
<tr>
<th>Information to Request User Input For</th>
<th>Setting the Host Profile Option</th>
</tr>
</thead>
</table>
| You are setting up the Fixed PSP configuration and want to prompt for the adapter and target IDs for the storage arrays that should use the Fixed PSP. | 1 Create a subprofile.  
   a Click **Storage configuration**.  
   b Click **Native Multipathing (NMP)**.  
   c Click **Path Selection Policy (PSP) configuration**.  
   d Right-click **Fixed PSP Configuration** and select **Add Profile**.  
| | 2 In the profile's Preferred Path window, select **Prompt the user for adapter and target IDs on the host**. |
| Configure FCoE adapter activation based on a user-specified MAC address. | 1 Open **Storage configuration**.  
2 Open **Software FCoE configuration**.  
3 Open **Adapter Configuration**.  
4 If no activation profile exists, right-click **Activation Profile** and select **New Profile**.  
5 Open the profile and click **Policy Profile**.  
6 Select **Activation policy based on adapter MAC address** from the drop-down menu. |

### Table 7-3. Host Profile Options that Prompt for Security User Input

<table>
<thead>
<tr>
<th>Information to Request User Input For</th>
<th>Setting the Host Profile Option</th>
</tr>
</thead>
</table>
| Administrator password for ESXi host when the host boots for the first time. | 1 Open **Security configuration**.  
   2 Click **Administrator password**.  
   3 Select **User Input Password to be Used to Configure Administrator Password**. |
| Preconfigures a user for the ESXi host but prompts for the password for that user on each host when the host boots for the first time. | 1 Create a user profile by right-clicking **User Configuration** and selecting **Add Profile**.  
2 Configure the user by selecting one of the options.  
   ■ **Assigned fixed user configurations** is available for compatibility with ESX/ESXi 4.1 system, this option displays the password in the clear.  
   ■ **Assign advanced fixed user configurations** is for users of ESXi 5.0 systems.  
   ■ **Specify the user configuration in the profile but prompt for password during host configuration** allows you to specify the information about the user but prompt for a password on each host. |
| Prompt the user for credentials when the host joins the Active Directory domain. | 1 Set the Authentication configuration profile to use a fixed domain.  
   a Open **Authentication configuration**.  
   b Open **Active Directory configuration**.  
   c Click **Domain Name**.  
   d Select **Configure a fixed domain name**.  
2 Set the method for joining the domain to prompt the user.  
   a Open **Authentication configuration**.  
   b Open **Active Directory configuration**.  
   c Click **JoinDomain Method**.  
   d Select **Use user specified AD credentials to join the host to domain**. |
### Table 7-4. Host Profile Options that Prompt for Networking User Input

<table>
<thead>
<tr>
<th>Information to Request User Input For</th>
<th>Setting the Host Profile Option</th>
</tr>
</thead>
</table>
| Prompt the user for the MAC address for a port group. You can have the system prompt the user in all cases (User specified MAC address...) or prompt the user only if no default is available. | 1 Open Networking configuration.  
2 Open Host port group.  
3 Open Management Network.  
4 Click Determine how MAC address for vmknic should be decided.  
5 Select how the system manages the MAC address.  
- User specified MAC Address to be used while applying the configuration  
- Prompt the user for the MAC Address if no default is available |
| Prompt the user for the IPv4 address for each ESXi host to which the profile is applied. You can have the system prompt the user in all cases (User specified IPv4 address...) or prompt the user only if no default is available. | 1 Open Networking configuration.  
2 Open Host port group.  
3 Open Management Network.  
4 Open IP address settings.  
5 Click IPv4 address.  
6 Select how the system manages the IPv4 address.  
- User specified IPv4 address to be used while applying the configuration  
- Prompt the user for the IPv4 address if no default is available |
| Prompt the user for the IPv6 address for each ESXi host to which the profile is applied. You can have the system prompt the user in all cases (User specified IPv6 address...) or prompt the user only if no default is available. | 1 Open Networking configuration.  
2 Open Host port group.  
3 Open Management Network.  
4 Open IP address settings.  
5 Click Static IPv6 address.  
6 Select how the system manages the IPv6 address.  
- User specified IPv6 address to be used while applying the configuration  
- Prompt the user for the IPv6 address if no default is available |
| Prompt the user for the DNS name of the host. You can have the system prompt the user in all cases (User specified host name...) or prompt the user only if no default is available. | 1 Open Networking configuration.  
2 Open DNS configuration.  
3 In the right panel, click Edit next to What is the name of this host.  
4 Select how the system manages the DNS configuration.  
- Prompt the user for host name if default is not available  
- User specified host name to be used while applying the configuration |
| Prompt the user for the MAC address for a distributed switch, its port group, or one of its services. Right-click the Host virtual NIC folder icon and click Add profile to determine the component to which the setting is applied. You can decide to prompt the user only if no default is available or in all cases. | 1 Open Networking configuration.  
2 Open Host virtual NIC.  
3 Open dvSwitch.  
4 Click Determine how MAC address for vmknic should be decided.  
5 Select how the system manages the MAC address for the distributed switch.  
- User specified MAC address to be used while applying the configuration  
- Prompt the user for the MAC address if no default is available |
### Table 7-4. Host Profile Options that Prompt for Networking User Input (Continued)

<table>
<thead>
<tr>
<th>Information to Request User Input For</th>
<th>Setting the Host Profile Option</th>
</tr>
</thead>
</table>
| Prompt the user for the IPv4 address for a distributed switch, its port group, or one of its services. Right-click the Host virtual NIC folder icon and click Add profile to determine the component to which the setting is applied. You can decide to prompt the user only if no default is available or in all cases. | 1  Open Networking configuration.  
2  Open Host virtual NIC.  
3  Open dvSwitch/dvPortGroup  
   The available port group depends on your environment.  
4  Open IP address settings.  
5  Click IPv4 address.  
6  Select how the system handles the IPv4 address for the distributed switch.  
   - User specified IPv4 address to be used while applying the configuration  
   - Prompt the user for IPv4 address if no default is available |
| Prompt the user for the IPv6 address for a distributed switch, its port group, or one of its services. Right-click the Host virtual NIC folder icon and click Add profile to determine the component to which the setting is applied. You can decide to prompt the user only if no default is available or in all cases. | 1  Open Networking configuration.  
2  Open Host virtual NIC.  
3  Open dvSwitch/dvPortGroup  
   The available port group depends on your environment.  
4  Open IP address settings.  
5  Click Static IPv6 address.  
6  Select how the system manages the IPv6 address for the distributed switch.  
   - User specified IPv6 address to be used while applying the configuration  
   - Prompt the user for IPv6 address if no default is available |
Auto Deploy Best Practices and Security Consideration

Follow best practices when installing vSphere Auto Deploy and when using Auto Deploy with other vSphere components. Follow security guidelines you would follow in a PXE boot environment, and consider the recommendations in this chapter.

This chapter includes the following topics:

- “Auto Deploy Best Practices,” on page 49
- “Auto Deploy Security Considerations,” on page 52

Auto Deploy Best Practices

This section discusses several Auto Deploy best practices. See the VMware Knowledge Base for additional best practice information.

Auto Deploy and vSphere HA Best Practices

You can improve the availability of the virtual machines running on hosts provisioned with Auto Deploy by following best practices.

- For hosts that can be part of a vSphere cluster, follow these steps.
  a. Enable vSphere HA on the cluster.
  b. Include the `vmware-fdm` VIB in the image profile that you want to use.
  c. Use PowerCLI to write a rule that assigns that image profile to the target hosts.

  If the image profile does not include the `vmware-fdm` VIB, a warning message appears on the PowerCLI console when you run the `New-DeployRule` or `Copy-DeployRule` cmdlet. The message includes information on how to add the VIB. See “vmware-fdm Warning Message When You Assign an Image Profile to Auto Deploy Host,” on page 54.

- Some environments configure the hosts provisioned with Auto Deploy with a distributed switch or configure virtual machines running on the hosts with Auto Start Manager. In those environments, deploy the vCenter Server system so that its availability matches the availability of the Auto Deploy server. Several approaches are possible.
  a. Deploy the vCenter Server system and the Auto Deploy server on the same system. This approach is especially well suited for a proof of concept environment.
  b. Deploy vCenter Server Heartbeat.

  VMware vCenter Server Heartbeat delivers high availability for VMware vCenter Server, protecting the virtual and cloud infrastructure from application, configuration, operating system, or hardware related outages.
Deploy the vCenter Server system in a virtual machine. Run the vCenter Server virtual machine in a vSphere HA enabled cluster and configure the virtual machine with a vSphere HA restart priority of high. Include two or more hosts in the cluster that are not managed by Auto Deploy and pin the vCenter Server virtual machine to these hosts by using a rule (vSphere HA DRS required VM to host rule). You can set up the rule and then disable DRS if you do not wish to use DRS in the cluster. The greater the number of hosts that are not managed by Auto Deploy the greater your resilience to host failures.

**Note** This approach is not suitable if you use Auto Start Manager because Auto Start Manager is not supported in a cluster enabled for vSphere HA.

### Auto Deploy Networking Best Practices

Prevent networking problems by following Auto Deploy networking best practices.

<table>
<thead>
<tr>
<th><strong>IP Address Allocation</strong></th>
<th>Using DHCP reservations is highly recommended for address allocation. Fixed IP addresses are supported by the answer file mechanism, but providing input for each host is cumbersome and not recommended.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VLAN Considerations</strong></td>
<td>Using Auto Deploy in environments that do not use VLANs is highly recommended. Do not use VLAN tagged networks at the boot NIC.</td>
</tr>
<tr>
<td></td>
<td>If you intend to use Auto Deploy in an environment that uses VLANs, you must make sure that the hosts you want to provision can reach the DHCP server. How hosts are assigned to a VLAN depends on the setup at your site. The VLAN ID might be assigned by the switch or by the router, or you might be able to set the VLAN ID in the host's BIOS or through the host profile. Contact your network administrator to determine the steps for allowing hosts to reach the DHCP server.</td>
</tr>
</tbody>
</table>

### Auto Deploy and VMware Tools Best Practices

See the VMware Knowledge Base for Auto Deploy and VMware Tools best practices.

### Auto Deploy Load Management Best Practice

Simultaneously booting large numbers of hosts places a significant load on the Auto Deploy server. Because Auto Deploy is a web server at its core, you can use existing web server scaling technologies to help distribute the load. For example, one or more caching reverse proxies can be used with Auto Deploy to serve up the static files that make up the majority of an ESXi boot image. Configure the reverse proxy to cache static content and pass requests through to the Auto Deploy server.

Configure the hosts to boot off the reverse proxy by modifying the TFTP tramp file. When you click **Download TFTP ZIP** in the vSphere Client, the system downloads the ZIP file that contains the tramp file. See “Prepare Your System and Install the Auto Deploy Server,” on page 18. Change the URLs in that file to refer to the address of the reverse proxy.

After a massive power outage, VMware recommends that you bring up the hosts on a per-cluster basis. If you bring up multiple clusters simultaneously, the Auto Deploy server might experience CPU bottlenecks. All hosts come up after a potential delay. The bottleneck is less severe if you set up the reverse proxy.
vSphere Auto Deploy Logging and Troubleshooting Best Practices

To resolve problems you encounter with vSphere Auto Deploy, use the Auto Deploy logging information from the vSphere Client and set up your environment to send logging information and core dumps to remote hosts.

**Auto Deploy Logs**

1. From a vSphere Client, connect to the vCenter Server system that Auto Deploy is associated with.
2. When the Certificate warning appears, select the check box, click **Ignore** and repeat if a second warning appears.
3. In the vSphere Client, click Home.
   An Auto Deploy icon is included in the display.
4. Click the Auto Deploy icon to display the Auto Deploy page.
5. In the Auto Deploy page, click **Download AutoDeploy Log Files**.

**Setting Up Syslog**

Set up a remote Syslog server. See the vCenter Server and Host Management documentation for Syslog server configuration information. Configure the first host you boot to use the remote syslog server and apply that host’s host profile to all other target hosts. Optionally, install and use the vSphere Syslog Collector, a vCenter Server support tool that provides a unified architecture for system logging and enables network logging and combining of logs from multiple hosts.

**Setting Up ESXi Dump Collector**

Hosts provisioned with Auto Deploy do not have a local disk to store core dumps on. Install ESXi Dump Collector and set up your first host so all core dumps are directed to ESXi Dump Collector, and apply the host profile from that host to all other hosts. See “Configure ESXi Dump Collector with ESXCLI,” on page 37 and “Set Up ESXi Dump Collector from the Host Profiles Interface,” on page 39.

**Using Auto Deploy in a Production Environment**

When you move from a proof of concept setup to a production environment, take care to make the environment resilient.

- Protect the Auto Deploy server. “Auto Deploy and vSphere HA Best Practices,” on page 49 gives an overview of the options you have.
- Protect all other servers in your environment including the DHCP server and the TFTP server.
- Follow VMware security guidelines, including those outlined in “Auto Deploy Security Considerations,” on page 52.
Auto Deploy Security Considerations

Understanding potential security risks helps you set up your environment in a secure manner.

Secure your network as you would for any other PXE-based deployment method. Auto Deploy transfers data over SSL to prevent casual interference and snooping. However, the authenticity of the client or of the Auto Deploy server is not checked during a PXE boot.

The boot image that the Auto Deploy server downloads to a machine can have the following components.

- The VIB packages that the image profile consists of are always included in the boot image.
- The host profile and answer file are included in the boot image if Auto Deploy rules are set up to provision the host with a host profile or answer file.
  - The administrator (root) password and user passwords that are included with host profile and answer files are MD5 encrypted.
  - Any other passwords associated with profiles are in the clear. If you set Active Directory by using host profiles, the passwords are not protected.

  Use the vSphere Authentication Service for setting up Active Directory to avoid exposing the Active Directory passwords.

- The host's public and private SSL key and certificate are included in the boot image.

The files that contain the host profile and answer file information are stored on disk in an obfuscated form. The files can be retrieved only as part of the waiter.tgz file that is generated for each host. The raw files are not accessible through the web server. However, malicious code can pretend to be a particular host and download a host's waiter.tgz file. The information in the waiter.tgz file can then be used to compromise the ESXi host.

You can greatly reduce the security risk of Auto Deploy by completely isolating the network where Auto Deploy is used.
Troubleshooting Auto Deploy

The Auto Deploy troubleshooting topics offer solutions for situations when provisioning hosts with Auto Deploy does not work as expected.

This chapter includes the following topics:

- “Auto Deploy TFTP Timeout Error at Boot Time,” on page 53
- “Auto Deploy Host Boots with Wrong Configuration,” on page 54
- “Host Is Not Redirected to Auto Deploy Server,” on page 54
- “vmware-fdm Warning Message When You Assign an Image Profile to Auto Deploy Host,” on page 54
- “Auto Deploy Host with a Built-In USB Flash Drive Does Not Send Coredumps to Local Disk,” on page 55
- “Package Warning Message When You Assign an Image Profile to Auto Deploy Host,” on page 56
- “Auto Deploy Host Reboots After Five Minutes,” on page 56
- “Auto Deploy Host Does Not Network Boot,” on page 57
- “Auto Deploy Host Does Not Get a DHCP Assigned Address,” on page 57
- “Auto Deploy Host Cannot Contact TFTP Server,” on page 58
- “Auto Deploy Host Cannot Retrieve ESXi Image from Auto Deploy Server,” on page 58
- “Recovering from Database Corruption on the Auto Deploy Server,” on page 59

Auto Deploy TFTP Timeout Error at Boot Time

A TFTP Timeout error message appears when a host provisioned by Auto Deploy boots. The text of the message depends on the BIOS.

Problem

A TFTP Timeout error message appears when a host provisioned by Auto Deploy boots. The text of the message depends on the BIOS.

Cause

The TFTP server is down or unreachable.

Solution

- Ensure that your TFTP service is running and reachable by the host that you are trying to boot.
Auto Deploy Host Boots with Wrong Configuration

A host is booting with a different ESXi image, host profile, or folder location than the one specified in the rules.

**Problem**

A host is booting with a different ESXi image profile or configuration than the image profile or configuration that the rules specify. For example, you change the rules to assign a different image profile, but the host still uses the old image profile.

**Cause**

After the host has been added to a vCenter Server system, the boot configuration is determined by the vCenter Server system. The vCenter Server system associates an image profile, host profile, or folder location with the host.

**Solution**

- Use the `Test-DeployRuleSetCompliance` and `Repair-DeployRuleSetCompliance` PowerCLI cmdlets to reevaluate the rules and to associate the correct image profile, host profile, or folder location with the host.

Host Is Not Redirected to Auto Deploy Server

During boot, a host that you want to provision with Auto Deploy loads iPXE. The host is not redirected to the Auto Deploy server.

**Problem**

During boot, a host that you want to provision with Auto Deploy loads iPXE. The host is not redirected to the AutoDeploy server.

**Cause**

The `tramp` file that is included in the TFTP ZIP file has the wrong IP address for the Auto Deploy server.

**Solution**

- Correct the IP address of the Auto Deploy server in the `tramp` file, as explained in the *vSphere Installation and Setup* documentation.

vmware-fdm Warning Message When You Assign an Image Profile to Auto Deploy Host

When users run PowerCLI cmdlets that assign an image profile to one or more hosts, an error results if the vmware-fdm package is not part of the image profile. This package is required if you use the Auto Deploy host with vSphere HA.

**Problem**

When users write or modify rules to assign an image profile to one or more Auto Deploy hosts, the following error appears:

```
WARNING: The supplied image profile does not contain the "vmware-fdm" software package, which is required for the vSphere HA feature. If this image profile is to be used with hosts in a vSphere HA cluster, you should add the vmware-fdm package to the image profile. The vmware-fdm package can be retrieved from the software depot published by this vCenter Server at the following URL:

http://<VC-Address>/vSphere-HA-depot
```

54  VMware, Inc.
You can use the Add-EsxSoftwarePackage cmdlet to add the package to the image profile and then update any hosts or rules that were using the older version of the profile.

**Cause**

The image profile does not include the vmware-fdm software package, which is required by vSphere HA.

**Solution**

If you will not use the Auto Deploy hosts in an environment that uses vSphere HA, you can ignore the warning.

If you will use the Auto Deploy hosts in an environment that uses vSphere HA, follow the instructions in the warning.

1. At the PowerCLI command prompt, add the software depot that includes the vmware-fdm package.
   ``` Powershell 
   Add-EsxSoftwareDepot http://VC-Address/vSphere-HA-depot
   ```

2. (Optional) If the image profile that generated the warning is read-only, clone the image profile.
   ``` Powershell 
   New-EsxImageProfile -CloneProfile My_Profile -name "Test Profile Error Free"
   ```
   This example clones the profile named My_Profile and assigns it the name Test Profile Error Free.

3. Run Add-EsxSoftwarePackage to add the package to the image profile.
   ``` Powershell 
   Add-EsxSoftwarePackage -ImageProfile "Test Profile Error Free" -SoftwarePackage vmware-fdm
   ```

**Auto Deploy Host with a Built-In USB Flash Drive Does Not Send Coredumps to Local Disk**

If your Auto Deploy host has a built-in USB flash drive, and an error results in a coredump, the coredump is lost. Set up your system to use ESXi Dump Collector to store coredumps on a networked host.

**Problem**

If your Auto Deploy host has a built-in USB Flash, and if it encounters an error that results in a coredump, the coredump is not sent to the local disk.

**Solution**

1. Install ESXi Dump collector on a system of your choice.
   ESXi Dump Collector is included with the vCenter Server installer.

2. Use ESXCLI to configure the host to use ESXi Dump Collector.
   ```
   esxcli conn_options system coredump network set IP-addr,port
   esxcli system coredump network set -e true
   ```

3. Use ESXCLI to disable local coredump partitions.
   ```
   esxcli conn_options system coredump partition set -e false
   ```
Package Warning Message When You Assign an Image Profile to Auto Deploy Host

When you run a PowerCLI cmdlet that assigns an image profile that is not Auto Deploy ready, a warning message appears.

Problem

When you write or modify rules to assign an image profile to one or more hosts, the following error results:

Warning: Image Profile <name-here> contains one or more software packages that are not stateless-ready. You may experience problems when using this profile with Auto Deploy.

Cause

Each VIB in an image profile has a stateless-ready flag that indicates that the VIB is meant for use with Auto Deploy. You get the error if you attempt to write an Auto Deploy rule that uses an image profile in which one or more VIBs have that flag set to FALSE.

Note You can use hosts provisioned with Auto Deploy that include VIBs that are not stateless ready without problems. However booting with an image profile that includes VIBs that are not stateless ready is treated like a fresh install. Each time you boot the host, you lose any configuration data that would otherwise be available across reboots for hosts provisioned with Auto Deploy.

Solution

1 Use Image Builder PowerCLI cmdlets to view the VIBs in the image profile.
2 Remove any VIBs that are not stateless-ready.
3 Rerun the Auto Deploy PowerCLI cmdlet.

Auto Deploy Host Reboots After Five Minutes

An Auto Deploy host boots and displays gPXE information, but reboots after five minutes.

Problem

A host to be provisioned with Auto Deploy boots from gPXE and displays gPXE information on the console. However, after five minutes, the host displays the following message to the console and reboots.

This host is attempting to network-boot using VMware AutoDeploy. However, there is no ESXi image associated with this host.

Details: No rules containing an Image Profile match this host. You can create a rule with the New-DeployRule PowerCLI cmdlet and add it to the rule set with Add-DeployRule or Set-DeployRuleSet. The rule should have a pattern that matches one or more of the attributes listed below.

The host might also display the following details:

Details: This host has been added to VC, but no Image Profile is associated with it. You can use Apply-ESXImageProfile in the PowerCLI to associate an Image Profile with this host.
Alternatively, you can reevaluate the rules for this host with the Test-DeployRuleSetCompliance and Repair-DeployRuleSetCompliance cmdlets.

The console then displays the host’s machine attributes including vendor, serial number, IP address, and so on.
Cause
No image profile is currently associated with this host.

Solution
You can temporarily assign an image profile to the host by running the Apply-EsxImageProfile cmdlet.
You can permanently assign an image profile to the host as follows.

1 Run the New-DeployRule cmdlet to create a rule that includes a pattern that matches the host with an image profile.
2 Run the Add-DeployRule cmdlet to add the rule to a ruleset.
3 Run the Test-DeployRuleSetCompliance cmdlet and use the output of that cmdlet as the input to the Repair-DeployRuleSetCompliance cmdlet.

See vSphere Installation and Setup documentation for details about vSphere Auto Deploy.

Auto Deploy Host Does Not Network Boot
The host you provision with Auto Deploy comes up but does not network boot.

Problem
When you attempt to boot a host provisioned with Auto Deploy, the host does not start the network boot process.

Cause
You did not enable your host for network boot.

Solution
1 Reboot the host and follow the on-screen instructions to access the BIOS configuration.
   If you have an EFI host, you must switch the EFI system to BIOS compatibility mode.
2 In the BIOS configuration, enable Network Boot in the Boot Device configuration.

Auto Deploy Host Does Not Get a DHCP Assigned Address
The host you provision with Auto Deploy fails to get a DHCP Address.

Problem
When you attempt to boot a host provisioned with Auto Deploy, the host performs a network boot but is not assigned a DHCP address. The Auto Deploy server cannot provision the host with the image profile.

Cause
You might have a problem with the DHCP service or with the firewall setup.

Solution
1 Check that the DHCP server service is running on the Windows system on which the DHCP server is set up to provision hosts.
   a Click Start > Settings > Control Panel > Administrative Tools.
   b Double-click Services to open the Services Management panel.
   c In the Services field, look for the DHCP server service and restart the service if it is not running.
2 If the DHCP server is running, recheck the DHCP scope and the DHCP reservations you configured for your target hosts.

If the DHCP scope and reservations are configured correctly, the problem most likely involves the firewall.

3 As a temporary workaround, turn off the firewall to see whether that resolves the problem.
   a Open the command prompt by clicking Start > Program > Accessories > Command prompt.
   b Type the following command to temporarily turn off the firewall. Do not turn off the firewall in a production environment.
      `netsh firewall set opmode disable`
   c Attempt to provision the host with Auto Deploy.
   d Type the following command to turn the firewall back on.
      `netsh firewall set opmode enable`

4 Set up rules to allow DHCP network traffic to the target hosts.
   See the firewall documentation for DHCP and for the Windows system on which the DHCP server is running for details.

**Auto Deploy Host Cannot Contact TFTP Server**

The host you provision with Auto Deploy cannot contact the TFTP server.

**Problem**

When you attempt to boot a host provisioned with Auto Deploy, the host performs a network boot and is assigned a DHCP address by the DHCP server, but the host cannot contact the TFTP server.

**Cause**

The TFTP server might have stopped running, or a firewall might block the TFTP port.

**Solution**

- If you installed the WinAgents TFTP server, open the WinAgents TFTP management console and verify that the service is running. If the service is running, check the Windows firewall’s inbound rules to make sure the TFTP port is not blocked. Turn off the firewall temporarily to see whether the firewall is the problem.
- For all other TFTP servers, see the server documentation for debugging procedures.

**Auto Deploy Host Cannot Retrieve ESXi Image from Auto Deploy Server**

The host you provision with Auto Deploy stops at the gPXE boot screen.

**Problem**

When you attempt to boot a host provisioned with Auto Deploy, the boot process stops at the gPXE boot screen and the status message indicates that the host is attempting to get the ESXi image from the Auto Deploy server.

**Cause**

The Auto Deploy service might be stopped or the Auto Deploy server might be unaccessible.

**Solution**

1 Log in to the system on which you installed the Auto Deploy server.
2 Check that the Auto Deploy server is running.
   a Click **Start > Settings > Control Panel > Administrative Tools**.
   b Double-click **Services** to open the Services Management panel.
   c In the Services field, look for the VMware vSphere Auto Deploy Waiter service and restart it if it is not running.

3 Open a Web browser and enter the following URL and check whether the Auto Deploy server is accessible.
   https://Auto_Deploy_Server_IP_Address:Auto_Deploy_Server_Port/vmw/rdb

   **NOTE** Use this address only to check whether the server is accessible.

4 If the server is not accessible, a firewall problem is likely.
   a Try setting up permissive TCP Inbound rules for the Auto Deploy server port.
      The port is 6501 unless you specified a different port during installation.
   b As a last resort, disable the firewall temporarily and enable it again after you verified whether it blocked the traffic. Do not disable the firewall on production environments.
      To disable the firewall, run `netsh firewall set opmode disable`. To enable the firewall, run `netsh firewall set opmode enable`.

**Recovering from Database Corruption on the Auto Deploy Server**

In some situations, you might encounter a problem with the Auto Deploy database. The most efficient recovery option is to replace the existing database file with the most recent backup.

**Problem**

When you are using Auto Deploy to provision the ESXi hosts in your environment, you might, in some situations, encounter a problem with the Auto Deploy database.

**NOTE** This is a rare problem. Follow all other Auto Deploy Troubleshooting strategies before you replace the current database file. Rules or associations that you created since the backup you choose are lost.

**Cause**

This problem happens only with hosts that are provisioned with Auto Deploy

**Solution**

1 Stop the Auto Deploy server service.
2 Find the log by using the vSphere Client. See “Auto Deploy Best Practices,” on page 49.
3 Check the logs for the following message:
   
   `DatabaseError: database disk image is malformed`.
   
   If you see the message, replace the existing database with the most recent backup.
4  Go to the Auto Deploy data directory.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>File Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCenter Server appliance</td>
<td>/var/lib/rbd</td>
</tr>
<tr>
<td>Microsoft Windows</td>
<td>The data directory you selected during installation. To find this directory, enter the following command into a command prompt. <code>reg.exe QUERY &quot;HKLM\SOFTWARE\WOW6432Node\VMware, Inc.\VMware vSphere Auto Deploy&quot; /v DataPath</code></td>
</tr>
</tbody>
</table>

The directory contains a file named `db`, and backup files named `db-yyyy-mm-dd`.

5  Rename the current `db` file.

VMware Support might ask for that file later.

6  Rename the most recent backup to `db`.

7  Restart the Auto Deploy server service.

8  If the message still appears in the log, repeat the steps to use the next recent backup until Auto Deploy works without database errors.
A proof of concept setup of an Auto Deploy environment helps administrators to evaluate the product and demonstrate its capabilities to management. When you complete the proof of concept setup workflow, you have a working Auto Deploy environment that includes a reference host and one or more other target hosts.

The proof of concept setup is intended for a test or development environment, but your completed setup can be the basis for a production environment. The set of tasks starts in an environment in which no Auto Deploy components are installed. The task descriptions assume that you are using a flat network with no VLAN tagging between the physical hosts and the rest of your environment.

To perform the tasks, you should have the following background knowledge and privileges.

- Experience with vSphere (vCenter Server, ESX, and ESXi).
- Basic knowledge of Microsoft PowerShell and vSphere PowerCLI.
- Administrator rights to the target Windows and vCenter Server systems.

Follow the tasks in the order presented in this document. Some steps can be performed in a different order, but the order used here limits repeated manipulation of some components.

This chapter includes the following topics:

- “Proof of Concept Preinstallation Checklist,” on page 62
- “Install the TFTP Server,” on page 63
- “Install and Set Up vSphere PowerCLI,” on page 63
- “Prepare Auto Deploy Target Hosts,” on page 64
- “Prepare the DHCP Server,” on page 64
- “Prepare the DNS Server,” on page 66
- “Install Auto Deploy Server Software,” on page 67
- “Configure the Auto Deploy and TFTP Environment,” on page 68
- “Prepare the ESXi Software Depot,” on page 68
- “Set Up the First Host and Provision with Auto Deploy,” on page 69
- “Configure the Proof of Concept Reference Host,” on page 71
- “Create a Host Profile,” on page 72
- “Create a Rule for Other Target Hosts,” on page 73
- “Provision All Hosts and Create Answer Files,” on page 75
Proof of Concept Preinstallation Checklist

Before you can start the proof of concept setup, make sure that your environment meets the hardware and software requirements and that you have the necessary permissions for the components included in the setup.

You need the following hardware and software for your proof of concept setup.

- vCenter Server 5.0 installed on a Windows system. In this proof of concept setup, you install the Auto Deploy server and the vSphere PowerCLI on the host on which the vCenter Server is running. You perform many of the setup tasks by logging in to that host, either directly into the console or by using Remote Desktop (RDP).
  - Datacenter, clusters, and folders configured on the vCenter Server system.
  - At least 4GB of free space on the vCenter Server system. Preferably a second volume or hard drive.
  - Storage for ESXi datastores (NFS, iSCSI, or FibreChannel), with servers and storage arrays that are configured so the servers can see the LUNs.
  - List of target IP addresses for NFS or iSCSI.
  - List of target volume information for NFS or iSCSI.
- Two or more hosts to be provisioned with Auto Deploy, and the following information for each host.
  - List of MAC addresses for each physical NIC.
  - List of IP addresses and fully qualified host names preassigned for target ESXi installs.
    - Default route, netmask, and primary and secondary DNS server IP addresses.
    - IP address and netmask for the VMkernel primary (management) network.
    - IP address and netmask for other VMkernel networks such as storage, vSphere FT, or VMware vMotion.

**CAUTION** If you set up Auto Deploy to boot a host, vSphere checks each of the local storage devices on the system for existing partitions. To avoid the possibility of data loss, vSphere does not create partitions under the following conditions:

- A local storage device contains a GPT partition map.
- A local storage device contains an MBR partition table that defines at least one partition.
- Storage is remote.

If hosts have local storage with a partition table that vSphere does not recognize, such as Linux Logical Volume Manager, vSphere overwrites the storage and creates new partitions. To make sure local storage is not considered for partitioning, you can physically disconnect that storage.

- vSphere installer (DVD or ISO).
- Window 7 or Windows Server 2008 system with Microsoft PowerShell preinstalled.
- vSphere PowerCLI installer binaries downloaded from the Downloads page on the VMware Web site.
- Location of the ESXi software depot on the Downloads page of the VMware Web site. You will use a URL to point to the image profile stored at that location or download a ZIP file to work with a local depot. Do not download the ESXi 5.0 image.
- TFTP installer software such as WinAgents TFTP server. The TFTP server included in Windows 2008 is closely tied to Windows network deployment and is not suitable.
- DHCP server. The DHCP server included with Windows 2008 is suitable.
You also need information about and administrator privileges to the environment’s core servers including the ActiveDirectory server, DNS server, DHCP server, NTP server, and so on.

You must have complete control of the broadcast domain of the subnet in which you will deploy the setup. Ensure that no other DHCP, DNS, or TFTP server are on this subnet.

Install the TFTP Server

Auto Deploy relies on a TFTP server for sending the boot image to the hosts it provisions. You must install a TFTP server in your environment.

This task only installs the TFTP server. You later download a configuration file to the server. See “Configure the Auto Deploy and TFTP Environment,” on page 68.

Prerequisites

Make sure your system meets the requirements in the Preinstallation Checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.

Procedure

1. Log in to the console of the Windows system on which vCenter Server is installed with administrator privileges, either directly or by using RDP.
2. Download and install the TFTP server software.
   - This sample setup uses the TFTP server from WinAgents. The TFTP server included with Windows 2008 is closely tied to Windows network deployment and not suitable for Auto Deploy.
3. Configure the TFTP root directory as D:\Drive or a similar location (for example, D:\TFTP_Root\).

What to do next

Install and set up vSphere PowerCLI. You use PowerCLI cmdlets to write the rules that assign image profiles and host profiles to hosts. See “Install and Set Up vSphere PowerCLI,” on page 63.

Install and Set Up vSphere PowerCLI

You manage Auto Deploy with rules that you create with vSphere PowerCLI cmdlets.

This proof of concept setup installs vSphere PowerCLI on the same system as the vCenter Server system. You can also install PowerCLI on a different Windows system.

Prerequisites

- Verify that Microsoft .NET 2.0 is installed, or install it from the Microsoft Web site following the instructions on that Web site.
- Verify that Microsoft Powershell 2.0 is installed, or install it from the Microsoft website following the instructions on that Web site.

PowerShell 2.0 is preinstalled on Windows 2008 and Windows 7 systems.

Procedure

1. Log in to the console of the Windows system on which vCenter Server is installed with administrator privileges, either directly by using RDP.
2. Open a command prompt and type the following commands in sequence.
   ```powershell
   powershell <Enter>
   Set-ExecutionPolicy RemoteSigned <Enter>
   Exit <Enter>
   ```
3 Download vSphere PowerCLI from the Download page of the VMware Web site and install the vSphere PowerCLI software.

4 Confirm that PowerCLI is working.
   a Double-click the PowerCLI icon on the desktop to open a PowerCLI window.
   b Ignore the SSL error, type `Get-DeployCommand`, and press Enter.
      PowerCLI displays a list of cmdlets and their definitions in the PowerCLI window.

What to do next
- If you do not see a list of cmdlets when you run `Get-DeployCommand`, check your PowerCLI version and uninstall and reinstall if necessary.
- For some background information on PowerCLI, see “Using Auto Deploy Cmdlets,” on page 21. See the vSphere PowerCLI documentation set for details.
- Prepare the hosts you want to provision with Auto Deploy. See “Prepare Auto Deploy Target Hosts,” on page 64.

Prepare Auto Deploy Target Hosts

You must prepare all target hosts for Auto Deploy.

Prerequisites

Hosts you want to provision with Auto Deploy must meet the requirements for ESXi.
See ESXi Hardware Requirements in the vSphere Installation and Setup documentation.

NOTE You cannot provision EFI hosts with Auto Deploy unless you switch the EFI system to BIOS compatibility mode.

Procedure

1 Change each physical host’s BIOS settings to force the host to boot from the primary network device.
2 Reconfirm the MAC address of the primary network device.

What to do next

Prepare the DHCP Server. See “Prepare the DHCP Server,” on page 64.

Prepare the DHCP Server

The DHCP Server in your proof of concept environment must be set up to serve each target host with an gPXE binary.

The proof of concept environment uses Active Directory with DNS and DHCP.

The proof of concept illustrates how to use DHCP reservations. Setting up fixed IP addresses for each host is time consuming and not recommended.

Prerequisites

- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.
Procedure

1. Log in to your DHCP Server as an administrator user.
2. Create a DHCP scope for your IP address range.
   a. Click Start > Settings > Control Panel > Administrative Tools and click DHCP.
   b. Drill down to DHCP > hostname > IPv4, right click, and click New Scope.
   c. Click Next on the Welcome screen and specify a name and description for the scope.
   d. Specify an IP address range and click Next.
   e. Click Next until you reach the Configure DHCP Options screen and select No, I will configure this option later.
3. If you are planning on using DHCP reservations, create a DHCP reservation for each target ESXi host.
   a. In the DHCP window, drill down to DHCP > hostname > IPv4 > Autodeploy Scope > Reservations.
   b. Right-click Reservations and select New Reservation.
   c. In the New Reservation window, specify a name, IP address, and the MAC address for one of the hosts. Do not include the colon (:) in the MAC address.
   d. Repeat the process for each of the other hosts.
4. Set up the DHCP Server to point the hosts to the TFTP Server.
   The precise process depends on the DHCP Server you are using. This example uses the DHCP server included with Windows 2008.
   a. In the DHCP window, drill down to DHCP > hostname > IPv4 > Autodeploy Scope > Scope Options.
   b. Right click Scope Options and choose Configure Options.
   c. In the Scope Options window, click the General tab.
d  Click **066 Boot Server Host Name** and enter the address of the TFTP server you installed in the String value field below.

![Image of Scope Options]

Click **Apply** and click **OK** to close the window.

e  Click **067 Bootfile Name** and enter `undionly.kpxe.vmw-hardwired`.

The `undionly.kpxe.vmw-hardwired` gPXE binary will be used to boot the ESXi hosts.

f  Click **Apply** and click **OK** to close the window.

5  In the DHCP window, right-click **DHCP > hostname > IPv4 > Scope > Activate** and click **Activate**.

6  Do not log out from the DHCP Server if you are using Active Directory for DHCP and DNS, or log out otherwise.

**What to do next**

Prepare the DNS Server. See “Prepare the DNS Server,” on page 66.

**Prepare the DNS Server**

Preparing the DNS server involves adding the DHCP information to the DNS server and verifying that the DNS entries are working. This task is optional.

The example environment uses Active Directory with DNS and DHCP.

**Prerequisites**

Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.

**Procedure**

1  Log in to the DNS server.

2  Add the DHCP reservation IP addresses and the associated host names as static DNS entries.

   Be sure to add entries in both Forward (ARecord) and Reverse (PTR Record) Zones.

3  Log in to the console of the Windows system on which vCenter Server is installed with administrator privileges, either directly or by using RDP.

4  Open a command prompt and perform an nslookup of ESXi host names to validate that the DNS entries are working.

   Use both forward (Short and FQDN) and reverse lookups.

5  Log out of your DNS server.
What to do next

Install the Auto Deploy Server software. See “Install Auto Deploy Server Software,” on page 67.

Install Auto Deploy Server Software

Auto Deploy server software is included with the vCenter Server installation media. This proof of concept setup installs the Auto Deploy server on the system on which vCenter Server is installed.

Prerequisites

- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.

Procedure

1. Log in to the console of the Windows system on which vCenter Server is installed with administrator privileges, either directly or by using RDP.
2. Secure the installation media for the Auto Deploy server software.

<table>
<thead>
<tr>
<th>vCenter Server type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual</td>
<td>Download the vSphere installer CD ISO image and place the ISO on a datastore the vCenter Server can access.</td>
</tr>
<tr>
<td>Physical</td>
<td>Download the vSphere installer CD ISO image and burn it to disk.</td>
</tr>
</tbody>
</table>

3. Make the ISO available to the vCenter Server.

<table>
<thead>
<tr>
<th>vCenter Server type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual</td>
<td>Attach the CD-ROM drive to the ISO, either by using the vSphere Client or from the datastore.</td>
</tr>
<tr>
<td>Physical</td>
<td>Insert the DVD into the physical server’s drive.</td>
</tr>
</tbody>
</table>

4. Run Autoplay on the DVD.
5. Select Auto Deploy Server and click Install.
6. When the installer wizard prompts you for the Repository Location, browse to the volume or hard drive that has enough storage for Auto Deploy use and select that location.

   Network shares are not an option when you install Auto Deploy.
7. Leave the defaults for everything else.
8. When the installer prompts you for credentials, use your vCenter Server administrator credentials.

What to do next

- If the vSphere Client software is not installed, install it now.
- Configure the Auto Deploy and TFTP environment. See “Configure the Auto Deploy and TFTP Environment,” on page 68.
Configure the Auto Deploy and TFTP Environment

You must download a TFTP Boot ZIP file from your Auto Deploy server. The customized TFTP server serves the boot images Auto Deploy provides.

**Prerequisites**

- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.

**Procedure**

1. From a vSphere Client, connect to the vCenter Server system, which is localhost in this proof of concept setup.
2. When the Certificate warning appears, select the check box, click **Ignore**, and repeat this process if a second warning appears.
3. In the vSphere Client, click Home.
   - An Auto Deploy icon is included in the display.
4. (Optional) If the Auto Deploy icon is missing, select **Plugins > Manage Plugins**, ensure Auto Deploy is enabled, and close the Plugins dialog.
5. Click the Auto Deploy icon to display the Auto Deploy page.
6. In the Auto Deploy page, click **Download TFTP Boot ZIP** in the Actions box.

```
Configuration

- BIDS DHCP File Name: undionly.kpxe.vmware-hardwired
- EFI DHCP File Name: snponly64.efi.vmware-hardwired
- gPXE Boot URL: https://192.168.1.26/rbd/tramp
- Cache Size: 2.00 GB
- Cache Space In Use: <1 MB

Actions
- Download TFTP Boot ZIP
- Download AutoDeploy Log Files
```

7. Save the file (deploy-tftp.zip) to the TFTP_Root directory that you created when you installed the TFTP Server and unzip the file into that directory.
8. Close the file browser and minimize the vSphere Client.

**What to do next**

Prepare the depot from which Auto Deploy retrieves the ESXi software when it provisions the hosts. See “Prepare the ESXi Software Depot,” on page 68.

**Prepare the ESXi Software Depot**

Auto Deploy provisions hosts with images described by image profiles. Image profiles are stored in software depots. You must make sure the correct image profile is available before you start provisioning hosts.

The ESXi software depot contains the image profiles and software packages (VIBs) that are used to run ESXi. An image profile is a list of VIBs. This proof of concept setup uses a depot and image profile provided by VMware and does not create custom image profiles.
This proof of concept setup downloads the ZIP file that contains the image profile. You can instead point the Auto Deploy server to the HTTP URL of an image profile.

If you require custom VIBs such as custom drivers in your image profile, you can create a custom image profile by using the Image Builder PowerCLI.

The steps in this task instruct you to run PowerCLI cmdlets. For additional information on each cmdlet, type `Help cmdlet` at the PowerCLI prompt or search the vSphere Documentation Center.

**Prerequisites**

- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.

- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.

**Procedure**

1. Log in to the console of the Windows system on which vCenter Server is installed with administrator privileges, either directly or by using RDP.

2. Download the ESXi Depot ZIP file from the VMware Web site to a location the PowerCLI Windows system can access.
   - The file has a name that follows this pattern: `VMware-Esxi-5.0.0-xxxxx-depot.zip`.

3. Save the ZIP file to your local D:\ drive or any volume with enough space and note the location of the file.

4. Start a PowerCLI session and run the following cmdlets at the prompt.

   ```powershell
   Connect-VIServer -Server your_vc_hostname -User username -Password password
   Add-EsxSoftwareDepot path:\VMware-Esxi-5.0.0-xxxxx-depot.zip
   ```

   Include the complete path and file name of the ZIP file you downloaded.

5. Validate that you successfully added the ZIP file to the depot by checking the contents of the depot with the `Get-EsxImageProfile` cmdlet.

   ```powershell
   Get-EsxImageProfile
   ```

   The cmdlet returns information about all image profiles in the depot.

**What to do next**

Set up Auto Deploy to provision the first host and provision that host with the image profile in the depot. See “Set Up the First Host and Provision with Auto Deploy,” on page 69.

### Set Up the First Host and Provision with Auto Deploy

Setting up the first host requires that you understand how to write Auto Deploy rules with vSphere PowerCLI. After you write the rules and add them to the ruleset, you can turn on the host to provision it.

You use the PowerCLI command-line interface to specify how Auto Deploy provisions the target hosts. You define rules and add each rule to the active ruleset. The Auto Deploy server checks the ruleset to determine which image profile to send to each ESXi host, which host profile to send to each ESXi host, and which location on the vCenter Server to place the host in.

A rule allows you to specify the following parameters.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the rule, specified with the –Name parameter.</td>
</tr>
<tr>
<td>Item</td>
<td>One or more items, specified with the –Item parameter. An item can be an image profile to be used, a host profile to be used, or a vCenter Server inventory location (datacenter, folder, cluster) for the target host. You can specify multiple items separated by commas.</td>
</tr>
<tr>
<td>Pattern</td>
<td>The pattern specifies the host or group of hosts to which the rule applies. Choose one of the following.</td>
</tr>
<tr>
<td>vendor</td>
<td>Machine vendor name.</td>
</tr>
<tr>
<td>model</td>
<td>Machine model name.</td>
</tr>
<tr>
<td>serial</td>
<td>Machine serial number.</td>
</tr>
<tr>
<td>hostname</td>
<td>Machine hostname.</td>
</tr>
<tr>
<td>domain</td>
<td>Domain name.</td>
</tr>
<tr>
<td>ipv4</td>
<td>IPv4 address of the machine.</td>
</tr>
<tr>
<td>mac</td>
<td>Boot NIC MAC address.</td>
</tr>
<tr>
<td>asset</td>
<td>Machine asset tag.</td>
</tr>
<tr>
<td>oemstring</td>
<td>OEM-specific strings in the SMBIOS.</td>
</tr>
</tbody>
</table>

Specify –AllHosts to apply the item or items to all hosts.

This proof of concept setup first uses –AllHosts and later uses an IP address range to identify the hosts to provision.

Write Rules for the First Host

You specify the image profile to provision the host with by using PowerCLI to write a rule and adding the rule to the active ruleset.

This task assumes you have a basic knowledge of Microsoft PowerShell and VMware PowerCLI.

Prerequisites

- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.
- Make sure you can access the ESXi 5.0 software you downloaded earlier from the system on which you run the PowerCLI cmdlets.

Procedure

1. Log in to the console of the Windows system on which vCenter Server is installed with administrator privileges, either directly or by using RDP.
   
   This task assumes you installed PowerCLI on the system on which the vCenter Server system is running.

2. Open the PowerCLI window and list the ESXi image profiles.

   Get-ExtImageProfile

3. Create a new rule by running the following cmdlet, replacing Esxi-5.0.0-XXXXX-standard with the image profile you want to use.

   New-DeployRule –Name "InitialBootRule" –Item "Esxi-5.0.0-XXXXX-standard" –AllHosts
4 Add the new rule to the active rule set to make the rule available to the Auto Deploy server.

   Add-DeployRule -DeployRule "InitialBootRule"

What to do next

Boot the host and check that Auto Deploy provisions the host and adds it to the vCenter Server inventory. See “Provision the First Host,” on page 71.

Provision the First Host

You can provision the first host and check its location on the vCenter Server to complete verification of the image provisioning of your setup.

Prerequisites

- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.

Procedure

1 Open a console session to the physical host you want to use as the first ESXi target host, boot the host, and look for messages that indicate a successful gPXE boot.

   During the boot process, DHCP assigns an IP address to the host. The IP address matches a name you specified earlier in the DNS server. The host contacts the Auto Deploy server and downloads the ESXi binaries from the HTTP URL indicated in the gPXE tramp file that you downloaded into the TFTP_Root directory earlier. Each instance of Auto Deploy produces a custom set of files for the TFTP Server.

2 Open the vSphere Client and connect to the vCenter Server system.

   In this proof of concept setup, the vCenter Server system is localhost.

3 Click Hosts and Clusters.

4 Check that the newly provisioned host is now in the vCenter Server inventory at the datacenter level.

   By default, Auto Deploy adds hosts at the datacenter level when the boot process completes.

What to do next

If you encounter problems, see Chapter 9, “Troubleshooting Auto Deploy,” on page 53.

Configure the first host for use as a reference host and save its host profile for use with other hosts. See “Configure the Proof of Concept Reference Host,” on page 71.

Configure the Proof of Concept Reference Host

You can customize the first ESXi host you boot for your environment and create a host profile. You can set up Auto Deploy to provision other target hosts with that host profile. The ESXi host you create the host profile from is considered your reference host or template host.

How you configure the reference host depends on what you want to do.

Shared settings

Specify settings all hosts share and save a host profile for the host.

Host-specific settings

You can customize hosts by setting up the host profile to prompt for user input for a limited number of options such as a static IP address. Those settings are saved in an answer file associated the reference host profile. See “Customizing Hosts with Answer Files,” on page 44.
Auto Deploy applies all common settings from the host profile to all target hosts. If you set up the host profile
to ask for user input, all hosts provisioned with that host profile come up in maintenance mode. You must
reapply the host profile or update the answer file to be prompted for the host-specific information.

**Note** Administrators cannot directly access or manipulate answer files. Use the vSphere Client Host Profiles
UI to work with answer files.

**Prerequisites**

- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept
  Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept
  Setup,” on page 61 for the complete list.

**Procedure**

1. Use the vSphere Client to connect to the vCenter Server system.
   In this proof of concept setup, the vCenter Server system is localhost.
2. Click Hosts and Clusters and select the host that Auto Deploy added to the first datacenter.
3. Configure the host.
   The rest of the proof of concept setup assumes that you configure at least one setting that is different for
different hosts.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Networking</td>
<td>Configure the following networking components.</td>
</tr>
<tr>
<td></td>
<td>- Base virtual switch and management port group for VMkernel.</td>
</tr>
<tr>
<td></td>
<td>- Storage network port group for VMkernel.</td>
</tr>
<tr>
<td></td>
<td>- Virtual machine networking port group.</td>
</tr>
<tr>
<td></td>
<td>- Any additional virtual switches and port groups.</td>
</tr>
</tbody>
</table>
|                 | - Distributed switches, if necessary (transfer port groups to distributed
  switches if you use them). |
| Storage         | Configure shared storage. |
| Time settings   | Configure your time settings. |
| Security        | Configure the security profile. |
| Authentication  | Configure authentication. |
| DNS and routing | If necessary, configure DNS and route settings |
| Other           | Configure advanced settings or any other settings as required in the target
  environment. |

**What to do next**

Create the host profile from the reference host for use with all other target hosts. See “Create a Host Profile,”
on page 72.

**Create a Host Profile**

Configuration that is shared by a group of hosts is stored in a host profile. You can create the host profile from
your reference host. Configuration that differs for different hosts, such as a static IP address, can be managed
through the answer file mechanism.

Auto Deploy provisions each host with a common host profile. In certain cases, Auto Deploy also uses a host-
specific answer file that allows you to specify information that differs for different hosts. For example, if you
set up a VMkernel port for vMotion or for storage, you can specify a static IP address for the port by using the
answer file mechanism.
In this example, you create a host profile from the reference host, attach that host profile to the same host, and create an answer file for the reference host.

**Prerequisites**
- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.

**Procedure**
1. With the vSphere Client, log in to the vCenter Server system with administrator privileges.
2. Click **Home** and select **Host Profiles**.
3. Click **Create a Host Profile** in the Getting Started tab on the right.
4. In the wizard, make the following selections.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Method</td>
<td>Create Profile from existing host.</td>
</tr>
<tr>
<td>Specify Reference Host</td>
<td>Select the host you just configured.</td>
</tr>
<tr>
<td>Profile Details</td>
<td>Name the profile ESXiGold and add a description.</td>
</tr>
<tr>
<td>Ready to Complete</td>
<td>Review the information and click Finish.</td>
</tr>
</tbody>
</table>

5. Right-click the ESXiGold host profile, select **Attach Host/Cluster**, select the ESXi host from which you created the profile, and click **OK**.

If any information is marked as user input in the host profile, you are prompted. In this example, no host profile items are set up to prompt you.

6. Put the host into maintenance mode and apply the host profile.
   a. Go to the Hosts and Clusters view, right-click the ESXi host, and put the host into maintenance mode.
   b. With the host in maintenance mode, right-click again, and select **Apply Profile**.

   vCenter Server checks the host for compliance and returns Compliant after the rescan is complete.

**What to do next**
Create a rule that assigns the image profile and the newly-created host profile to all hosts you want to provision with Auto Deploy. See “Create a Rule for Other Target Hosts,” on page 73.

**Create a Rule for Other Target Hosts**

You can create a rule that applies the previously verified image profile and the host profile you just created to all target hosts.

This task assumes you have a basic knowledge of Microsoft PowerShell and vSphere PowerCLI.

**Prerequisites**
- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.
Procedure

1. Log in to the console of the Windows system on which vCenter Server is installed with administrator privileges, either directly or by using RDP.

2. Start a PowerCLI session and type the following commands at the prompt.

   ```powershell
   Connect-VIServer -Server your_vc_hostname -User username -Password password <Enter>
   Add-ESxSoftwareDepot path:\VMware-Esxi-5.0.0-xxxxx-depot.zip <Enter>
   ```

   Include the complete path and file name of the ZIP file you downloaded earlier. Adding the software depot is required each time you start a new PowerCLI session.

3. (Optional) Display the rules in the active ruleset by typing the following cmdlet at the prompt.

   ```powershell
   Get-DeployRuleset <Enter>
   ```

4. Create the rule that instructs Auto Deploy to provision the set of hosts in the specified IP range with the image you selected and with the host profile you created from the reference host.

   ```powershell
   New-DeployRule -name "Production01Rule" -item "image_profile", ESXiGold, target_cluster -
   Pattern "ipv4=IP_range" <Enter>
   ```

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>image_profile</td>
<td>The ESXi image profile you used in the first deploy rule.</td>
</tr>
<tr>
<td>target_cluster</td>
<td>Name of the cluster in vCenter Server to which you want to add all hosts.</td>
</tr>
<tr>
<td>IP_range</td>
<td>Either a single IP address or a range of IP addresses for the hosts you want to provision with the image profile and host profile.</td>
</tr>
</tbody>
</table>

   When you specify a target cluster, the host profile is applied to all hosts in the cluster. Applying the host profile to each host is not required.

5. Add the new rule to the active ruleset.

   ```powershell
   Add-DeployRule -DeployRule "Production01Rule" <Enter>
   ```

6. (Optional) Remove the deploy rule you created for the initial boot operation.

   ```powershell
   Remove-DeployRule -DeployRule InitialBootRule <Enter>
   ```

7. Check the active rule set.

   ```powershell
   Get-DeployRuleset <Enter>
   ```

   PowerCLI displays information similar to the following example.

   ```powershell
   Name:              Production01Rule
   PatternList:       {ipv4=address_range}
   ItemList:          {ESXi-5.0.0-XXXXXX-standard, Compute01, ESXiGold}
   ```

What to do next

Provision all hosts and create an answer file for each host. See “Provision All Hosts and Create Answer Files,” on page 75.
Provision All Hosts and Create Answer Files

With the rule in place that provisions hosts using an image profile, and with the host profile created from the reference host available, you can provision all target hosts. If any host profile items are set to prompt the user for input, the host comes up in maintenance mode. You apply the host profile or update the answer file to be prompted for the information. The system creates the answer file and associates it with the host.

Prerequisites

- Make sure your system meets the requirements in the preinstallation checklist. See “Proof of Concept Preinstallation Checklist,” on page 62.
- Perform all preceding proof of concept setup tasks. See Chapter 10, “Auto Deploy Proof of Concept Setup,” on page 61 for the complete list.
- Open a console to each host you want to provision to monitor boot progress.

Procedure

1. Boot the remaining hosts.
   Auto Deploy boots the hosts, applies the host profile, and adds the hosts to the vCenter Server inventory. The hosts remain in maintenance mode because the host profile from the reference host is set up to require user input for each host.
2. Open a vSphere Client and connect to the vCenter Server system.
3. Click Home and select Host Profiles.
4. In the panel on the left, select the ESXiGold profile and add the newly booted hosts to that profile.
5. Apply the host profile to each of the hosts, provide the user input information, and reboot each host.
   When the reboot progress completes, all hosts are running with the image you specify and use the configuration in the reference host profile. The cluster shows that all hosts are fully compliant.

All hosts are now configured with the shared information through the reference host profile and with the host-specific information through the answer file. The next time you boot the hosts, they retrieve that information and boot completely.

What to do next

With your proof of concept implementation completed successfully, you can start planning your production setup.
Index

A
active rule set 7
Add-DeployRule 73
advanced management (Auto Deploy) 41
answer file 5, 34, 42
answer files 44, 75
Apply-ExslImageProfile cmdlet 33
Auto deploy, answer file 42
Auto Deploy
answer files 75
best practices 49
boot file 18
boot operation 5
boot process 8
change target vCenter Server 43
coredump 55
DHCP address 57
DHCP reservations 64
DHCP server 18, 64
DNS Server 66
failing to complete boot 56
failure to boot 58
gPXE boot 71
host profiles 72
image profile warning 56
installing 67
network boot problem 57
networking 40
PowerCLI cmdlets 15
PowerCLI installation 63
PowerCLI setup 63
preparing 17
proof of concept 61
proof of concept checklist 62
provisioning hosts 31
rebooting 32
redirection problem 54
reference host 35, 71
reprovisioning hosts with 32
reregister 41
rule set compliance 28
rules 69
static IP address 42
tasks 13
TFTP server 18, 58
timeout error 53
troubleshooting 53
tutorial 61
user input 32
wrong image 54
Auto Deploy daemon 41
Auto Deploy image 68
Auto Deploy on vCenter Server Appliance 43
Auto Deploy PowerCLI 21, 25
Auto Deploy PowerCLI cmdlets 7
Auto Deploy roadmap 13
Auto Deploy rules 27, 28
Auto Deploy server 5
auto-deploy register command 43
B
best practices, Auto Deploy 49
BIOS UUID 5
boot file (Auto Deploy) 18
boot operations 5
boot process, Auto Deploy 8
bulk licensing 22
C
cluster location, assign with Auto Deploy 28
Connect-VIServer cmdlet 25, 27, 28, 33
Copy-DeployServer cmdlet 33
D
database corruption, Auto Deploy 59
DHCP reservations, Auto Deploy 64
DHCP Scope 64
DHCP Server, Auto Deploy 64
DHCP server for Auto Deploy 18
DNS Server, Auto Deploy 66
Download TFTP ZIP 18
Dump Collector 37, 38
E
esxcli system coredump 37
ESXi Dump Collector
host profiles 39
reference host 39
<table>
<thead>
<tr>
<th>Letter</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>folder location, assign with Auto Deploy 28</td>
</tr>
<tr>
<td>G</td>
<td>Get-Help PowerShell cmdlet 21</td>
</tr>
<tr>
<td>H</td>
<td>host profile from reference host 71</td>
</tr>
<tr>
<td></td>
<td>host profiles assign with Auto Deploy 27</td>
</tr>
<tr>
<td></td>
<td>Auto Deploy 38</td>
</tr>
<tr>
<td></td>
<td>Auto Deploy rule 73</td>
</tr>
<tr>
<td></td>
<td>Network Coredump 38</td>
</tr>
<tr>
<td></td>
<td>reference host for Auto Deploy 71</td>
</tr>
<tr>
<td></td>
<td>host provisioning 5</td>
</tr>
<tr>
<td></td>
<td>hosts, reprovisioning with Auto Deploy 32</td>
</tr>
<tr>
<td>I</td>
<td>image profile 68</td>
</tr>
<tr>
<td>L</td>
<td>LicenseDataManager 22</td>
</tr>
<tr>
<td></td>
<td>licensing, bulk licensing 22</td>
</tr>
<tr>
<td>M</td>
<td>MAC address 5</td>
</tr>
<tr>
<td></td>
<td>Microsoft .NET 21</td>
</tr>
<tr>
<td></td>
<td>Microsoft PowerShell 21</td>
</tr>
<tr>
<td>N</td>
<td>network boot 64</td>
</tr>
<tr>
<td></td>
<td>network core dump 37</td>
</tr>
<tr>
<td></td>
<td>New-DeployRule 70, 73</td>
</tr>
<tr>
<td></td>
<td>New-DeployRule cmdlet 25, 27, 28</td>
</tr>
<tr>
<td>P</td>
<td>PowerCLI 25</td>
</tr>
<tr>
<td></td>
<td>PowerCLI cmdlets, Auto Deploy 15</td>
</tr>
<tr>
<td></td>
<td>preinstallation checklist 62</td>
</tr>
<tr>
<td>R</td>
<td>reference host 38</td>
</tr>
<tr>
<td></td>
<td>Auto Deploy 38</td>
</tr>
<tr>
<td></td>
<td>configuration options 37</td>
</tr>
<tr>
<td></td>
<td>reference host for Auto Deploy 35</td>
</tr>
<tr>
<td></td>
<td>registration of Auto Deploy 41</td>
</tr>
<tr>
<td></td>
<td>Repair-DeployRulesetCompliance cmdlet 28</td>
</tr>
<tr>
<td></td>
<td>rule engine 7</td>
</tr>
<tr>
<td></td>
<td>rule set 5</td>
</tr>
<tr>
<td></td>
<td>rule set compliance 28</td>
</tr>
<tr>
<td></td>
<td>rule sets 7</td>
</tr>
<tr>
<td></td>
<td>rules 7, 73</td>
</tr>
<tr>
<td>S</td>
<td>SMBIOS information 5</td>
</tr>
<tr>
<td></td>
<td>snap-in, Auto Deploy 21</td>
</tr>
<tr>
<td></td>
<td>software depot 68</td>
</tr>
<tr>
<td></td>
<td>state 5</td>
</tr>
<tr>
<td></td>
<td>static IP address for Auto Deploy 42</td>
</tr>
<tr>
<td></td>
<td>syslog, host profile 39</td>
</tr>
<tr>
<td></td>
<td>syslog, Auto Deploy 39</td>
</tr>
<tr>
<td>T</td>
<td>target hosts 64</td>
</tr>
<tr>
<td></td>
<td>template host for Auto Deploy 35</td>
</tr>
<tr>
<td></td>
<td>Test-DeployRulesetCompliance cmdlet 28</td>
</tr>
<tr>
<td></td>
<td>TFTP Boot ZIP 68</td>
</tr>
<tr>
<td></td>
<td>TFTP server 58</td>
</tr>
<tr>
<td></td>
<td>Auto Deploy 58</td>
</tr>
<tr>
<td></td>
<td>installing 63</td>
</tr>
<tr>
<td></td>
<td>TFTP server for Auto Deploy 18</td>
</tr>
<tr>
<td></td>
<td>timeout error, Auto Deploy 53</td>
</tr>
<tr>
<td>U</td>
<td>unregister Auto Deploy 43</td>
</tr>
<tr>
<td></td>
<td>user input for Auto Deploy 34</td>
</tr>
<tr>
<td></td>
<td>user input for Auto Deploy hosts 32</td>
</tr>
<tr>
<td>V</td>
<td>vCenter Server Appliance, Auto Deploy 42, 43</td>
</tr>
<tr>
<td></td>
<td>vCenter Server Appliance:Auto Deploy 42, 43</td>
</tr>
<tr>
<td></td>
<td>vmk0 40</td>
</tr>
<tr>
<td></td>
<td>vmware-fdm package 54</td>
</tr>
<tr>
<td></td>
<td>vmware-rbd-watchdog 43</td>
</tr>
<tr>
<td></td>
<td>vSphere Auto Deploy, installing 20</td>
</tr>
<tr>
<td></td>
<td>vSphere HA, Auto Deploy 54</td>
</tr>
<tr>
<td></td>
<td>vSwitch0 40</td>
</tr>
<tr>
<td>W</td>
<td>waiter.tgz file 52</td>
</tr>
<tr>
<td></td>
<td>working rule set 7</td>
</tr>
</tbody>
</table>